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Executive Summary

The University of Florida Electronic Communications Laboratory has performed a
research project for the Florida Department of Transportation (FDOT) designed to
enhance the capability of the FDOT to utilize ground penetrating radar (GPR) for
surveying subsurface characteristics. The project began in September 1997, has a
completion date of September 30, 1999 (with a no-cost time extension), and has resulted
in a new graphical software environment that improves FDOT ability to process and
analyze GPR data. Recommendations have also been provided concerning data collection
practices. This final report summarizes the work performed on the project. A User’s
Manual for the software tool has been included as an appendix.

The FDOT State Materials Office provided the University of Florida with a response and
evaluation letter for the draft final report and the GPR software tool on July 13, 1999. As
requested in the FDOT/SMO letter, this final version of the report contains this executive
summary, a summary of the salient project accomplishments, limitations of the resulting
GPR software tool, and recommended areas for future work.

Several significant accomplishments have been achieved during the course of this project.
The major contribution takes the form of a graphical software environment that enhances
FDOT productivity concerning GPR use in several beneficial ways. The software provides
intuitive use through graphical controls. Visualization of results is significantly improved
with respect to previous FDOT capabilities. The software includes a selection of modern
processing algorithms which enhance the profile data and aid in visual interpretation of
subsurface features. Means of efficient data manipulation and file storage have been
included in the package to simplify FDOT efforts. Finally, results of profile editing and
processing may be output in several forms for compatibility with commercial software
packages, allowing integration of processed images into FDOT results documentation.
Another project contribution includes recommendations for radar system configuration
and data collection techniques, both of which help ensure the quality of collected data for
analysis.

In summary, the GPR software and analysis tool provided by the Electronic
Communications Laboratory will improve the FDOT capacity for beneficial use of GPR
radar for non-destructive analysis of subsurface anomalies for geophysical applications.
Utilization of GPR and this software tool offers the potential for FDOT cost savings when
used for pre-construction surveying, maintenance evaluations, and post-construction
subsurface analysis.







1.0 Introduction

This report serves to document research conducted by the Electronic Communications
Laboratory at the University of Florida for the Florida Department of Transportation
under HPR Study No. 860, WPI # 0510860, State Job 99700-3558-119, Contract No. BB-
260. The project title was “Ground Penetrating Radar (GPR) Signal Processing
Enhancements for Geophysical Anomaly Identification.” The initiation date of the project
was September 8, 1997 and the project completion date is September 30, 1999 (with no-
cost time extension). This report describes progress throughout the course of the project.

The purpose of this project was to improve GPR utility for Florida Department of
Transportation (FDOT) geophysical applications, such as anomaly identification, by
improving measurement techniques and signal processing techniques. The project had
several specific objectives. A primary objective was to develop a capability to use GPR
data and signal processing techniques to generate improved display of subsurface areas.
This capability will allow the FDOT staff to better identify and locate subsurface artifacts
and anomalies than was previously possible. A secondary objective was to develop
measurement techniques that will provide more information about subsurface material
properties, i.e., moisture content, dielectric constant, and possibly other properties.

Signal processing algorithms which were found to provide significant improvements in
GPR analysis were coded into an efficient GPR processing software environment. This
environment was customized to maximize utility for the FDOT geophysical application.
A graphical user interface (GUI) has been provided to ensure intuitive operation with
minimal operator training required. The software package allows display of enhanced
GPR profiles which benefit subsurface interpretation and reduce the experience necessary
for an informative analysis.

2.0 GPR Challenges

Processing of ground penetrating radar signals provides quite a challenge due to specific
issues inherent in the data collection methods and in the use of radar for the specific
purpose of imaging objects at close range underground.

2.1 Collection of Data

For geophysical applications, the radar is typically used by the FDOT to survey an area
which is marked off in a grid. The radar antenna is usually pulled by hand along the
gridlines while a button on the antenna is pressed every time an intersecting gridline is
crossed. Each such pass is called a traverse. During each traverse, the GPR transmits and
receives a series of pulses into the ground. The measurements of the pulses, also called
traces, are stacked next to each other to form a ground profile--an image of the subsurface
response for a single traverse. This data collection method introduces two errors in the
data. First, the radar samples at a constant rate; however, as the operator walks pulling the
antenna, the pace of walking cannot be entirely consistent. The sample interval in cross-
range of the radar is, therefore, not constant. This problem distorts objects in a profile and
cannot be corrected. Second, the markers set in the data at crossing gridlines are set when
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the antenna marker button is pressed. This measurement, once again, introduces human
error since the crossing of gridlines is judged “by eye”. These problems created by the
method of data collection cannot realistically be avoided; although, they may be kept to a
minimum by careful, meticulous collection efforts.

2.2 Ground Coupling

GPR may be used for several specific applications. It is often used for thin layer pavement
evaluation and thickness measurements. However, this report focuses on the department’s
use of the radar for analysis of deeper artifacts and anomalies. This application requires
significantly greater signal penetration than that of thin layer evaluation. For this reason,
ground coupled antennas are used rather than air-launched versions. Ground coupled
antennas are placed directly on the surface, allowing electromagnetic coupling of the
ground with the antenna. The antenna no longer sees the surface as a reflecting interface
because the ground is now considered part of the antenna. The large loss of transmitted
radiation due to reflection from the air-surface interface is, therefore, not experienced.
Hence, a greater magnitude of the transmitted signal actually enters the ground for returns
from subsurface objects. This advantage does not come without a cost. The surface
reflection is not as obvious in the GPR profile as with air-launched antennas. Estimation
is now required for the first layer. Another cost involves the electromagnetic coupling of
the antenna with the ground. The transmitted signal may no longer be measured for use in
matched filtering, inversion, or other signal processing methods. In fact, since the antenna
is being pulled across the ground, the source signal is modified in a different manner by
each surface the antenna contacts. So, ground coupling allows sufficient penetration for
analysis of deeper objects, but it creates challenges to GPR processing development for
ground coupled applications.

2.3 Hyperbolic Effect

Ground penetrating radars have a beamwidth of approximately 90 degrees or more.
Because of this wide beamwidth, the radar is able to “see” an object and register a return
before the radar is directly over the object. In fact, the radar integrates all the returns from
surfaces perpendicular to the wave propagation for each time location within the antenna
beamwidth. The time (and therefore the distance) to a target appears in a GPR profile to
be greatest when the GPR first “sees” the target, but it is actually the correct value when
the artifact is directly below the antenna. As the antenna passes the target, the time
measurement to the target response increases again. Once again, only responses from
surfaces which are perpendicular to the wavefront propagation reflect electromagnetic
radiation back to the antenna and are “seen”. Point targets, which are omni-directional
having perpendicular surfaces in all directions, produce a hyperbolic shaped response, as
can be seen in many profiles. Due to the same phenomenon, objects with extent that do
not contain horizontal surfaces appear to be shifted horizontally because their returns were
measured when the antenna was not directly overhead. This hyperbolic effect spreads the
energy or information in the return from an object into a complex pattern which is often
capable of rendering features in a profile indistinguishable. Objects in a profile which are
in close proximity to each other demonstrate returns that overlap and add together, causing
even more difficulty in interpretation of the patterns found in GPR profiles.







3.0 Progress

The progression of research throughout this project evolves from the pursuit of three main
tasks. This first of these tasks is the collection of relevant data from the system of interest.
In this case the FDOT department’s GSSI SIR-10B ground penetrating radar must be used
to acquire data from ground truthed regions in order to provide measurements for analysis
of the applicability of new signal processing methods. The second task involves the study
and development of signal processing algorithms which may benefit GPR profile
visualization and interpretation. These algorithms must enhance features of objects in
subsurface profiles to ease the uncertainty which currently plagues GPR analysis. Due to
the volumes of data involved in this application, the routines must be written to work
efficiently if they are to operate with reasonable analysis times. Finally, the third task is
comprised of the development of a software environment which facilitates intuitive use of
the advanced signal processing and efficient completion of routine GPR analysis. These
three tasks have been carried out somewhat in parallel during the course of this project.

FIGURE 1. GPR Test Pit
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3.1 Acquisition of Meaningful Data

In order to effectively determine the usefulness of signal processing algorithms for GPR,
data from the radar must be provided for study. It is critical that the data represent a
known subsurface such that the appropriate correlations may be made between algorithm
results and the responses from actual physical artifacts. In order to collect the required
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data from a ground truthed area, a GPR test pit was constructed with a collaborative effort
between the ECL and the FDOT at a location provided on FDOT property. This pit was
designed by the ECL to provide radar responses from a set of specific, known targets
which are typically used for radar system development. The targets were buried in the pit
in known locations so that collection could be efficiently taken and appropriately
documented. A diagram of the pit follows in Figure 1. Upon construction of the GPR test
pit, the radar was used to survey the area. Traces were recorded in a grid-like fashion as
documented in the Figure 1 illustration. Data was collected first using the 500MHz
antenna, which provides good resolution and penetration for imaging objects buried to one
meter depth, as those placed in the test pit. Data was later collected using the 900MHz
antenna to provide greater resolution with less penetration. The test pit provided an
acceptable set of ground truthed data for analysis and algorithm evaluation.

FIGURE 2. GPR Profile collected from test pit
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3.2 Development of GPR Processing Algorithms

3.2.1 Background Removal

Horizontal bands frequently obscure more important information in a GPR profile. These
bands sometimes result from ringing of the antenna, ground coupling effects, or the
response from some artifact maintaining a constant distance from a poorly shielded
antenna. Routines have been written which remove banding in a response profile. The
algorithms assume that any response which is constant for the entire profile, or for a user
selected range, is useless information. The algorithms, therefore, average the traces over
the given cross-range and subtract the result from each trace in the profile. This procedure
effectively removes the banding and quite often reveals pertinent data. The routine must







be used with caution due the possibility of removing responses from anomalies with
significant horizontal extent.

3.2.2 Median Filter

On occasion, profile displays contain a significant amount of what is called “salt and
pepper” noise before or after processing. The phenomenon exerts itself as high valued,
outlying points in an image. These points seldom truly represent meaningful points in a
data set and often cloud the image with a grainy appearance and/or an inappropriate color
scaling. One solution to this problem, which is often used in many image processing
applications, is a median filter. Median filters take all the points within an area around a
pixel and return the median of the points as the pixel’s new value. This effectively
removes any outlying points and produces a less corrupted display. To improve the
appearance and produce a truer representation of GPR data, a median filter has been added
to the list of GPR signal processing options.

3.2.3 Signed dB Display

Data collected by the GPR may typically range in amplitude over several orders of
magnitude. This makes visualization of many profiles difficult, if not impossible, using a
linear scale. A linear scale distributes the allocated colors evenly between the lowest
value in a data set to the highest value in a data set. Very high values often cause small
values to be indistinguishable when the data is displayed. This is usually true of GPR data
due to the exponential attenuation of the electromagnetic signal during propagation
through the subsurface. Returns from near-surface objects will be very high when
compared to reflections from deeper objects. To improve the display of such large
dynamic range profiles, the signals are often displayed in decibels(dB), which is computed
by taking twenty times the LOG of the data. The displayed dynamic range is, therefore,

compressed allowing both high amplitude and low amplitude returns to be seen.
However, computing the LOG,, requires taking the absolute value, since LOG ), of
negative numbers does not exist. It is, therefore, common practice to just take the absolute
value of the data before displaying in decibels. While this method often helps provide a
better display, any information contained in the sign of the data is discarded. When
interpreting GPR profiles, the sign of the peaks of the returned reflections are quite often
very beneficial for understanding subsurface artifacts. With the goal of improving the
display of wide dynamic range data without losing information contained in the sign of the
data, a new method of display was employed. This new method takes the typical unsigned
dB data and gives it the appropriate sign, which is obtained from the sign of the original
data. The resulting display provides for effective visualization of GPR in many instances
without loss of sign information.

3.2.4 Histogram Equalization

When colors are allocated for the display of data, they are most often distributed in a linear
manner. This means that the colors are ranked in some order according to some
predefined colorscale. The top color value is assigned to the highest sample value in the
data while the bottom color value is assigned to the lowest sample value in the data. All
the colors between the top and bottom are allotted data values which are evenly distributed







between the highest and the lowest values. The colors are, therefore, allocated without
regard for where the data values are most prevalent within the determined range. This
method is perfectly acceptable in many instances. In fact, it works very well, and it
provides a linear association between the data value and the position of the color within
the color range. Generally this linear color association is more natural or intuitive.
However, there are many situations when this method provides little to no color separation
between features of interest within a data set. For example, suppose there are both a few
very high data values and a few very low data values within a given data set. In this set
consider also that a majority of the data values are within a much smaller range
somewhere in the middle of the set, with no values of data points in the substantial regions
between this central group of points and either the small, high group or the small, low
group. In the linear allocation scheme, colors will be assigned evenly between the highest
group and the lowest group. Many colors will be wasted in the display of the data because
they will be assigned to data values which do not exist in the data set: values between the
middle group and the high or low groups. There will be few of the limited number of
colors available to display the very large middle group of points. These few colors will be
distributed evenly over the important middle set of points, and each point will be
displayed using the color representing a value which is closest to the actual data value.
Small differences in the actual data values, which may represent significant features in the
data, may not be visible because they are mapped to the same color as a result of the
insufficient number of colors available for their display. A better scheme, in this instance,
will allocate the available colors only in the ranges where data values exist within the set.
In this way, all colors will be used to visualize the data without wasting colors. Histogram
equalization is a method of color assignment which performs just this task. Before
determining where colors should be distributed, histogram equalization maps out the
number of occurrences of each data value within a given set. It then chooses to assign the
colors such that each color is used an equal number of times in displaying the data.
Narrow congregations of data with many representative points, having small differences
between them, now receive a sufficient number of colors for the mapping of small
differences in value to different colors. The important features may now be visible,
whereas before they might not have been. Histogram equalization works very well in
many instances. Sometimes, however, it applies too many colors and makes interpretation
difficult. In these cases, normal color assignment is preferable. Histogram equalization
complements the standard linear allocation very well, and with viewer discretion succeeds
in significantly improving the visibility, and therefore interpretation, of GPR profiles.

3.2.5 Gain Function Removal

Collection of profile data is subject to a gain function which is applied to the received
signal. This gain function can be automatically set by the radar, or the function may be
manually chosen by the system operator. This gain magnifies the value of the response in
an attempt to compensate for the attenuation of the signal moving deeper into the
subsurface. Often this procedure makes very small returns from deep artifacts visible.
However, there are two potential problems with such a method that can often affect signal
processing algorithms adversely. First, the noise level inherent in the system is also
amplified with the desired signal. This noise can become significantly large and disrupt
processing and visualization. Second, the gain function applied causes an unnatural







response with respect to the inherent properties of the subsurface medium. Processing
designed to interpret subsurface characteristics based upon the natural response from
object features may not handle the corruption of the response by some arbitrary gain
function which is in no way correlated to the features themselves. For these reasons, it is
often desired to remove the gain function from the data prior to processing with certain
algorithms. The characteristics of the gain function, which was applied to the data upon
collection by the radar system, are saved within the header information of the data file. A
routine was written which is able to retrieve the appropriate gain function information
from the header and then apply the inverse of the function to the profile data. This
effectively returns the response of the subsurface without gain corruption for further
processing. '

FIGURE 3. Profile example: Gain Removed
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3.2.6 Simple Migration

Migration is the process of focusing the hyperbolic responses of point targets in GPR
profiles to points with the goal of providing a more meaningful representation of the
subsurface for interpretation. Fixing the problem, however, is not a simple task. Several
difficulties arise. First, not all responses are from point targets and do not, therefore, have
a nice hyperbolic shape. Few prior assumptions can be made about the subsurface to
remedy this problem. Second, the inconsistent cross-range sample rate corrupts the shape
of the responses, so matching hyperbolas to the responses can sometimes prove difficult.
Third, the hyperbolic shape depends on the velocity of the electromagnetic wave in the
medium, which is not constant for most situations. So, the responses may be distorted by
gradients in the dielectric constant, which cannot be determined to a sufficient extent to
correct the problem. Finally, interference from multiple nearby targets creates a much







more complex response. With all this said, the possibility of migration in GPR sounds
nearly impossible; but, in many situations, it may in fact be helpful. Typical use of the
radar often involves locating utilities such as buried pipes and cables, or rebar--all of
which respond as point targets in a perpendicular cross-section. The dielectric may vary a
significant amount between targets located in different sections of a profile, but it will
often be consistent enough in the immediate area around a specific target. If the data is
carefully collected such that the cross-range sample rate maintains a relatively constant
sample interval, then migration can be of use for improving the interpretation and cross-
range localization of the object of interest, particularly point targets.

The simple migration algorithm uses the physical geometry of the radar system and the
resulting hyperbola associated with an un-migrated point target in a GPR profile image to
migrate GPR data. It can be shown that the hyperbolic shape for a point target will be a
specific shape for a given target depth, medium dielectric constant, and radar antenna
beamwidth. The algorithm uses the assumption that the target is a point object with
sufficient returned energy to be discernible from the profile background, where no
significant level returns were detected. With this assumption the algorithm thresholds the
amplitude data from the GPR and only processes significantly high responses which are
considered to be likely candidates for point targets. If the GPR image pixel is above the
threshold, the hyperbolic shape is calculated for the specified GPR beamwidth, medium
dielectric, and depth of the target. The energy contained along the hyperbola is then
integrated or summed to create the new value for the pixel at the hyperbola’s apex. This
effectively collapses the hyperbolic shape to a more point-like object, as is more
appropriate for interpretation. The process is repeated for each pixel in the profile which
meets the threshold requirement. Focusing the point targets also narrows the extent of the
target response in cross-range, providing a more precise location of the object. The
migration algorithm may also be used to estimate the dielectric of the medium
surrounding point targets in a profile. The algorithm can be run using a range of dielectric
values. When the most accurate dielectric estimate is used for migration, the algorithm
will produce the most focused results.

3.2.7 Fast Fourier Transform Migration

Another method of profile migration was originally developed for seismic data processing
by Stolt [3]. It has also been used for Synthetic Aperture Radar (SAR) applications, which
are similar in nature to the geophysical application of the FDOT. Stolt’s algorithm takes
advantage of relationships between traveling wavefronts in the frequency domain. This
method of processing transforms the time-domain profile into the 2-D frequency domain.
It is able to use Fast Fourier Transforms for this conversion, which results in a remarkably
efficient algorithm and extremely fast operation. Once in the frequency domain, a spatial
transformation, discovered by Stolt, is executed to perform the required focusing, and then
the inverse Fast Fourier Transform is performed to return the migrated GPR profile. This
method of processing has proven to be very fast when compared to the point processing
involved in the simple migration algorithm. Its results are good with objects that are good
approximations of true point targets, when the dielectric is chosen appropriately. For
other targets, the simple migration method often works a little better. Some of the
limitations of the Fast Fourier Transform migration method are perhaps due to the







assumption made that the propagating wavefront is planar. The assumption is valid for
far-field analysis in seismic and SAR applications; however, the GPR application is a
near-field problem. Nonetheless, the algorithm is fast and may be helpful in many
situations. It may be used in a like manner to the simple migration method for estimation
of the dielectric constant as well.

FIGURE 4. Migration examples: Unmigrated, Simple Method, FFT Method

3.2.8 Blind Deconvolution

One way of considering the GPR subsurface imaging problem is to interpret the ground as
a filter. The source waveform from the radar would be the input to the filter, and the
received signal would be the output from the filter. This filter could be generalized as a
series of impulses, having an impulse at each interface between layers of differing
dielectrics. What is seen as the output in a GPR profile is the result of the source
waveform being filtered by, or convolved with, the ground response. This response
appears similar to a “mexican hat” waveform at each interface. The “mexican hat” has a
high main lobe and two smaller, negative sidelobes. One reason GPR profiles are difficult
to interpret is that each interface returns a waveform with multiple lobes of alternating
sign. Ideally, it would be easier to interpret a profile if the profile were more like the
original subsurface response, which consists of one high amplitude, narrow peak at each
interface. The desired profile, the impulse response of the ground, can be attained by
separating, or mathematically speaking, deconvolving the source waveform from the
returned response. However, this filtering cannot be done when a ground coupled radar is
used because the input signal is a function of the ground coupling and, therefore, is not
accurately known or measurable. Resolving this problem calls for more creative methods.
One such method is known as blind deconvolution. The deconvolution procedure is
considered “blind” because it must separate both signals without knowing either one of
them. In order to do this, one of the signals is modeled as a white noise process, while the
other is modeled as linearly predictable. Both the additive noise and the subsurface
impulse response may be modeled as a white noise process due to their random nature; no
combination of previous values of the samples tells anything about the next samples. The
input signal, however, may be approximately modeled as the impulse response of an all-
pole, minimum-phase filter. This means that each sample value is a linear combination of
previous samples, and the next sample may be effectively predicted from the current
sample and previous ones. In summary, the input signal may be predicted, with an
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appropriate filter, from current and previous samples while the ground response and
additive noise may not. This assumption is very beneficial and allows for an estimated
deconvolution of the two signals. To perform this blind deconvolution, an adaptive filter
is utilized. The filter is designed to predict the next value of each sample in a trace as it
filters the trace. After each prediction, the error between the predicted value of the trace
and the actual value is used to modify the values of the filter such that it is more capable of
predicting the next value. Hence, the filter adapts to minimize the error between what it
predicts as the next sample in a trace and the measured sample.

FIGURE 5. Blind Deconvolution example

down ronge (m) = with surfaee esiimofe

Creas Ronge

The filter gets closer and closer to being able to predict the next value until it is predicting
as well as possible. At this point, the filter is said to have “converged” to an estimate of
the model for the input signal. If the adaptive filter is now predicting the next value of the
input, then the error between the predicted value and the actual value must be that which it
cannot predict in the measured response: the noise-like response of the ground and the
additive noise in the system. This error, therefore, is an estimate of the impulsive
subsurface filter having high, narrow responses at each layer interface. Algorithms have
been coded which implement this blind deconvolution scheme and return an estimated
profile of the ground impulse filter. Many assumptions were made to produce the blind
deconvolution algorithm. The results of the algorithm are only as good as the assumptions
which are made. For this reason, it is easy to understand why an ideal ground response
profile is not achieved. In fact, the assumptions in no way accounted for the hyperbolic
integration problem mentioned previously. However, the assumptions are good enough to
enable the blind deconvolution algorithm to benefit interpretation of GPR profiles. The
algorithm is capable of collapsing some of the responses, which are widespread in the







down-range time-domain, into denser clusters of information. Recognition of true
responses from objects is significantly improved in many profiles using the blind
deconvolution algorithm.

3.2.9 Impulse Forcing

Profiles are easily cluttered by wide bands of color which exist in the display because of
the wide crests and troughs of the electromagnetic source waveform, the wide beamwidth
response pattern, and the interference between neighboring objects. An algorithm has
been designed which often alleviates some of the visual overload associated with these
many complex phenomena. The Impulse Forcing algorithm filters each trace in a profile
and returns an impulse, weighted by the original sample value for every sample that meets
the following criterion: 1. The sample must be the highest valued sample within a sliding
window of a user specified width centered around the sample, and 2. The sample must be
a certain percentage, determined by a user specified threshold, higher than the standard
deviation of all the samples within the sliding window.

FIGURE 6. Impulse Forcing example
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This algorithm attempts to replace broadly shaped returns with fine lines at the positive
and negative peaks subject to a specified window size. It also attempts to ignore low
amplitude peaks which are probably not from legitimate returns by comparing their value
with the standard deviation within the sliding window. The peak must be of significant
size compared to the surrounding data samples to register as an impulse. The Impulse
Forcing procedure emphasizes the slopes and curvatures of responses within a profile and
presents some insight into subsurface features. The algorithm may be used on the
unprocessed profile and can also be informative when applied after the Blind







Deconvolution process. Typically, the results of this algorithm are best viewed in signed
decibel mode without histogram equalization.

3.2.10 Multiresolution Analysis

GPR signals do not readily lend themselves to typical frequency analysis. The measured
waveforms are not stationary and, therefore, have a frequency content that varies with
time. Fourier analysis determines the frequency content of the entire signal, but fails to
provide any time information content. This is the exact dual to the original measured time
series providing only time information, but no frequency information content. One
possible solution to many non-stationary signal processing applications involves a
relatively new concept known as multiresolution analysis using the wavelet transform.
The underlying principle in Fourier analysis is a comparison of the signal of interest with
cosine functions of varying frequencies.

FIGURE 7. Multiresolution example
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High correlation between the signal and a particular frequency indicates the presence of
that frequency in the waveform. In this manner, a signal may be dissected into the
frequency components, of which it is composed. Cosine functions are of infinite extent,
causing time to be absent in the frequency decomposition. The wavelet transform uses
basis functions other than cosines in the signal decomposition. These basis functions,
called wavelets, are finite in extent and have a very narrow frequency content. In
frequency analysis, the signal of interest is compared to cosines of varying frequency. In
wavelet analysis, the signal is compared to wavelets of varying scales. The wavelet scale
is a variable in the wavelet function which determines the frequency and extent of the
waveform, just like frequency in the cosine function does to the cosine waveform. The







wavelet waveform changes, based upon its scale, from low frequency with long extent to
high frequency with short extent. Therefore, because the wavelet basis functions have
both frequency and finite extent, the final wavelet transform contains both time and
frequency information. This time-frequency component is called resolution. A signal
may be decomposed into its multiple resolutions by comparison with wavelets through a
range of scales--hence the notion of “multiresolution analysis”. Similar to frequency
filtering, where only the important frequencies in a signal are kept; once a signal has been
decomposed using the wavelet transform, the desirable resolutions may be kept while the
unimportant are discarded. In this way, features in the signal may be selectively chosen
based upon their resolution. Such processing may be applied to measured GPR returns
and proves to be beneficial in enhancing the returns from artifacts while reducing clutter
in the display of GPR profiles. Subsurface features are, therefore, more easily recognized,
and interpretation is significantly improved. Algorithms providing such processing have
been developed. They allow user selection of the most beneficial scale, as well as a choice
of several wavelet basis functions which are provided. Multiresolution analysis provides
excellent results in many situations and is quite fast due to the Fast Fourier Transform
method used to compute the wavelet transform.

3.3 Design of GPR Graphical Environment

A major goal of this project is to improve the capacity of the FDOT in making meaningful
interpretations of GPR profiles through enhanced signal processing techniques. With this
goal in mind, methods of signal processing were studied and analyzed for applicability to
GPR processing tasks.

FIGURE 8. GUI display
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Procedures which were determined to provide suitable utility were coded for use in Visual
Numerics’ PV-Wave mathematical analysis software. These algorithms process the radar
data; however, it was imperative that a graphical environment, or Graphical User Interface
(GUI), be developed to facilitate the manipulation of GPR files and data, to provide
intuitive access and operation of processing routines, and to display results in a visually
beneficial format. Such an environment has been designed to fulfill these needs.

3.3.1 File Access

The file format of the GPR environment was designed to both load and save profile data in
a manner which is compatible with software currently used by the FDOT. The FDOT uses
a software package called RADAN to view and manipulate GPR profiles. Output from
the GSSI SIR-10B radar system is saved to disk using RADAN’s file format. The GPR
software is capable of loading the RADAN file format and accessing the data and header
information within. In an effort to increase utility of the GPR processing package for the
FDOT, file output routines were written to save data and header information such that
RADAN can access GPR environment processed profiles. This adds flexibility in FDOT
analysis capabilities, allowing processing and visualization of data through any
combination of the routines from either or both software packages.

3.3.2 Profile Editing

Functions were added to the ECL GPR processing environment which make editing of a
GPR profile data file simple and efficient. All editing tools are easily accessed in menus
of the GUI and provide for such functions as cropping out a section of interest for
processing, deleting a section of unimportant data, automatically removing the gain
function applied to the data by the radar, or modifying the gain by applying any gain
function to the data set. The modify gain function has its own graphical tool for designing
a gain function for use on the data. Editing of GPR profiles allows extremely large data
files to be broken into smaller more manageable pieces. It also permits the user to extract
only the data of interest for processing. This reduces the size of the data set and greatly
increases the processing time required.

3.3.3 Data Processing

All of the GPR signal processing algorithms mentioned previously are integrated into the
GUI and are readily available for use by the FDOT GPR specialists. Each processing
routine has a graphical tool designed for efficient control of parameter selection and
operation. The GUI makes use of all GPR algorithms easy, and all results are immediately
displayed for user interpretation.

3.3.4 GUI Display

Processing of the data is not enough: intelligent data displays are required for meaningful
visualization and an informed interpretation. The subsurface response is displayed in the
main window of the GPR environment GUI. Perhaps the most influential elements of an
effective display are the choice of colors and their allocation scheme. The main GPR
display supplies freedom for the user to tailor these features of the profile display to best
suit the visual information presented for each profile, before or after processing. A
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selection of color tables has been provided for emphasizing various aspects of data, and a
graphical tool has been designed to allow for the adjusting of these tables to maximize
their utility. This capability greatly improves the visibility of significant qualities of the
subsurface responses in the ECL GPR environment in comparison to previous GPR
software packages used by the FDOT. The main profile display also supplies other
display options, some of which were mentioned with the processing development section,
including: decibel display, absolute value, histogram equalization, and median filtered
display. The vertical axis of the display has several beneficial options. The axis may be
displayed in sample number, sample time, or in depth estimate mode. Depth estimate
mode requires user estimation of the dielectric constant for depth calculation. This
dielectric estimate may be known from soil tests or it can be estimated using the
‘mentioned migration estimate methods. It is also possible, if a target is buried at a known
depth, to change the dielectric parameter until the display indicates the proper depth of the
object. The dielectric constant associated with this correct depth indication may be used
as an estimate of the medium dielectric. The GUI also contains a plot of the gain function
currently applied to the data, and a command feedback display to provide information
concerning the last procedure performed by the software.

3.3.5 Multiple Register Handling

The ECL GPR processing environment was designed with effort made to maximize
efficiency and utility in the processing and analysis tasks required for typical FDOT GPR
use. In an attempt to attain additional efficiency, data within the software is handled in
two registers: X and Y. Upon loading a new profile, the profile data is entered in both
registers. Only register X is displayed in the main display, and all processing within the
environment is performed only on register X. At any point, the operator, using buttons on
the GUI, may switch the contents of the X and Y registers. The contents of register X may
also be copied into register Y at any time using a similar button. This system, with
minimal practice, allows the user to keep two sets of the same profile data set at all times.
Each one may be processed independently and compared to the other. The original file
may be reloaded into register X by another button without disturbing the contents of
register Y. The ability to compare and contrast features in the data, extracted by various
forms of processing, greatly improves the GPR analysis system.

3.3.6 Final Results Editing

Once the processing has been completed and final results need to be documented, the
processed profile image in the main display may be imported into a tool designed for
annotating, printing, or exporting. The editor allows object oriented text, lines, ellipses,
and boxes to be drawn in a variety of colors for annotation in the profile. The annotated
product may be saved to disk for later modification as well. Additional features of the
post-processing editor include zoom, statistical analysis of the pixel data, and multiple
direction single slice plots. The tool is capable of printing to a file, so the image may be
used in other desktop publishing software, as is often necessary for FDOT reports and
papers. The post-processing editor completes the GPR signal processing environment,
providing an enhanced signal processing system, tailored for the FDOT GPR processing
application requirements.







4.0 Conclusion

This report completes documentation of work performed in the development of an
improved GPR processing and analysis package for the Florida Department of
Transportation. Methods of enhanced signal processing for GPR information extraction
have been researched and developed. A graphical software environment tool has been
produced making use of beneficial algorithms and providing direct application of new
processing techniques. With FDOT GPR analysis capacity significantly improved by the
development and installation of the new GPR processing software on the FDOT GPR
analysis computer, the Electronic Communications Laboratory at the University of Florida
concludes its research effort for the Florida Department of Transportation under HPR
Study No. 860, WPI # 0510860, State Job 99700-3558-119, Contract No. BB-260, entitled
“Ground Penetrating Radar (GPR) Signal Processing Enhancements for Geophysical
Anomaly Identification.”

4.1 Accomplishments
The following is a list of the accomplishments during the geophysical project:

1. Development of a graphical ground penetrating radar analysis environment was
completed. This system provides a software tool that benefits the FDOT analysis
personnel through an intuitive software interface, greatly improved subsurface
visualization, enhanced subsurface profiles from modern processing techniques,
simplified and efficient file/data management, and improved flexibility for results
integration with commercial documentation software.

2. Progress was made in the field of GPR signal processing through the consideration and
application of many modern signal processing algorithms to the enhancement of GPR
data. Processing algorithms included in the provided software package improve
visualization and the information present in representations of the subsurface profile.

3. Management of large GPR data sets was improved with the ability to section and
modify extremely large data files into smaller sections of meaningful data. This allows
for additional gains in processing speed by reduction of insignificant regions of
collected data.

4. The main product of the FDOT often takes the form of reports documenting results
found during area surveys using the GPR. Integration of such results was previously
difficult. However, the ECL software package provides improved flexibility for simple
transfer of processing results into commercial word processing and graphic design
software packages. This simplifies the FDOT documentation practices and improves
the efficiency of FDOT GPR analysis.

5. GPR data collection procedures were refined and improved throughout the course of
this project as FDOT personnel became more informed of the scientific principles
involved in GPR collection and analysis. The ECL has outlined goals and suggestions
for improved collection techniques and has worked to improve FDOT personnel’s
understanding of pertinent GPR fundamentals. These efforts have resulted in better
GPR data, better educated FDOT utilization of radar capabilities, and more informed
FDOT analysis.







4.2 Recommendations for Further Improvements

This project has greatly improved the capacity of the FDOT for GPR analysis and
documentation. However, there is room for future progress. The following items may be
considered for continued development of GPR utility.

1.

Processing of collected GPR data remains in an early stage of development.
Enhancement and information processing of GPR images is a difficult task. Continued
research of new algorithms and processing schemes may provide additional gains in
analysis results.

. The software environment currently allows vertical, two-dimensional display of only

one traverse. Further improvements may investigate the possibility of combining
multiple traverses in a grid-like fashion into a horizontal display of the survey area.
This may provide additional information concerning the characteristics of subsurface
objects.

. Speed of processing algorithms may be addressed in future efforts. Although

processing speed was a consideration during algorithm coding, additional work could
be done to promote the processing efficiency of operation.

. Future efforts could, perhaps, focus on the principles involved in data collection with

the GPR system and investigate possible methods of increasing the information
retrieved during data collection with changes to the collection system.

5.0 References

Several references have been identified as being very beneficial to the development of
two-dimensional migration, reverse migration algorithms, adaptive deconvolution, and
wavelet analysis. These references are listed below.

1. Clarebout, J. F., 1985, Imaging the Earth’s Interior: Blackwell Scientific Publications.
2. Haykin, S,. 1996, Adaptive Filter Theory: Third Edition.

3. Stolt, R. H., 1978, Migration by Fourier Transform: Geophysics, v. 43, 23-48.

4. Torrence, C. and G. P. Compo, 1998: A Practical Guide to Wavelet Analysis: Bull.
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6.0 Appendix A:

The attached document, which follows, is the User’s Manual for the ECL GPR
environment software. The manual serves as an appendix to this final project report.
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CHAPTER 1

Basics

This chapter introduces basic operation tasks for use of the Ground Penetrating
Radar Signal Processing Environment (GPRSPE) software. It covers the following:

o Overview

¢ Basic Procedures

Overview

This software was designed to improve the capacity of the Florida Department of
Transportation (FDOT) in making meaningful interpretations of ground penetrating
radar (GPR) profiles through enhanced signal processing techniques. With this goal
in mind, methods of signal processing were studied and analyzed for applicability
to GPR processing tasks. Procedures which were determined to provide suitable
utility were coded for use in Visual Numerics’ PV-Wave mathematical analysis
software. These algorithms process the radar data; however, it was imperative that a
graphical environment, or Graphical User Interface (GUI), be developed to
facilitate the manipulation of GPR files and data, to provide intuitive access and
operation of processing routines, and to display results in a visually beneficial
format. This User’s Manual serves to document and demonstrate the appropriate
use of the graphical environment designed to fulfill that purpose.

GPR Processing Environment -- User’s Manual 11



Basics

Basic Procedures

This section covers the basic concepts involved with operation of the GPR
processing software. These concepts involve:

e Software initialization

¢ System display features

¢ Menu operation

¢ Register management

* File handling

¢ Software exiting

Software Initialization

Software initialization is the procedure for starting the GPRSPE software. This task
involves two simple steps.

1. Start Visual Numerics’ PV-Wave software.
From the Windows START menu, under the PV-Wave folder, begin a PV-Wave
session.

2. At the wave prompt, type @ GoGPR. Then press RETURN.

This should start the GPRSPE GUI which will open on the desktop.

System Display Features

The GPRSPE display contains
multiple regions for profile
display, system feedback and
environment control. These
regions serve to optimize the
functionality of the GPR
processing software.
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Basic Procedures

1. Profile Display

The main display area is the where profile data is displayed.

def’n: Profile - a GPR image of the subsurface consisting of a series of traces,
which are recorded as the radar antenna is traversed along the surface.

The image displayed here represents the subsurface, with cross-range on the
horizontal axis and down-range on the vertical axis. The cross-range scale, scen in
the main window, shows the radar trace number.

def’n: Trace - one measured pulse of the radar consisting of a series of samples/
measurements as electromagnetic wave propagates into the ground and returns
from subsurface reflections.

Scroll bars below the main window allow sliding through profiles that are wider
than the display. Markers placed in the data by the radar are displayed as white
vertical lines.

2. Vertical Axis
The down-range scale has its own window where it displays the vertical scale in

either samples, time, or depth. The depth display is an estimate based on the travel
time and dielectric constant of the medium, which is supplied by the operator.

3. Gain Function Display

A gain function may be applied to the data by the radar or by the GPRSPE
software.

GPR Processing Environment -- User’s Manual 13
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def’n: Gain Function - a function applied to each trace which amplifies the data
according to its sample number. Typically, in GPR, early samples receive little
amplification while late samples in a trace receive larger amplification. This helps
account for the lower amplitude of the later samples due to attenuation caused by
their deeper penetration.

This gain is meant to amplify small signal returns from
deep objects in order to make them visible. The current
gain function affecting the profile data is displayed in
the Gain Function Display window.

4. Command Feedback Display

As the GPRSPE is used, feedback from each procedure is displayed in a text box at
the bottom of the environment display. This information provides the parameters,
etc. from the last operation.

Welcame to the Graphical Envitonment for Ground Penetraling Radar Signal Processing for Geophysical Applications -

Developed for the Floida Department of Transportation by the
Electionic Communications Laboratory of the Universiy of Florida

Go Gators! ,"_J

5. Display Parameters Box

The current display options and the colorscale are displayed. The
options buttons may be selected on or off to change the display.

def’'n: Colorscale - the array of colors allotted for the display of
data. Each color is assigned to represent a data value in the display
according to some allocation scheme. Points in the data set are dis-
played using the color closest to their data value.

6. Filename Display

The current file name is displayed in its own text box. If the name
is longer that the box width, the entire name will not be visible. If 0.000000
this is the case, clicking in the box and scrolling over will make

the filename visible.

[J:\projectstfdotgeotdatat0s_
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7. Down-range Scale Options Box

Davwn Bange
. . . . g ione:
Several options are available for units of the vertical Scale Options:
scale. These options are selected with the Scale L
) ) ! . {+ Samples
Options buttons. Display of depth requires an estimate e
of the dielectric constant of the subsurface medium. C Time
def’'n: Dielectric Constant - a parameter of any medium ~ D thr ,
which determines the velocity of electromagnetic waves S ep S
within that medium. . :
Dielectric
i i ) o Estimnate
This parameter is set by the operator using the sliderin | g
the Down-range Scale Options box. ‘D“

8. Button Bar

Many operations may be selected using the buttons on the GPRSPE display. The
Button Bar functions will be discussed further in the following sections of this
manual.

[REDRAY] [0 (00 fecf [T

XY
9. Menu Bar

The menu bar allows selection of a majority of the GPRSPE functions. Its use and
the functions available will be discussed in the following sections of this manual.

_File  Edit ~Process ~View

Menu Operation

Most of the system operations are initiated through use of the GPRSPE menus
found in the Menu Bar. The operations are divided into appropriate categories 50
that desired functions may be located intuitively.
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To select a menu option, simply click on

RS BTG ED LB R R EENRY:  that option using the mouse pointer. One of

=" Edit Process View three things will happen depending on the

LoadNew Image - H_:": choice’s function:
Reload Previous Image "\ | ¢ A list of other choices will appear.

Save Image. * A graphic tool will appear for additional
Save Selection function control.
Stop . . . .

. . 1l be eration.
ViewAnnotate/Print o The chosen function will begin operation

Exit

Register Management

The GPRSPE was designed with effort made to maximize efficiency and utility in
the processing and analysis tasks required for typical FDOT GPR use. In an attempt
to attain additional efficiency, data within the software is handled in two registers:
X and Y. Upon loading a new profile, the profile data is entered in both registers.
Only register X is displayed in the main display, and all processing within the
environment is performed only on register X. At any point, the contents of X and Y
may be switched. The contents of X may also be copied into register Y at any time.
This system, with minimal practice, allows the user to keep two sets of the same
profile data set at all times for independent processing and comparison using
differing methods.

Register management is primarily handled using buttons on the Button Bar.

[F =X

IX*—*Y‘ -- Switches the contents of X and Y.

X=Y]

Reloading the file into X may also be performed using the Reload Previous Image
choice under the File menu. Switching the registers may be selected in the Edit
menu with Swap Disp Image.

-- Reloads the previously loaded file into X only.

-- Copies the contents of X into Y.
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File Handling

Before any processing can be done, GPR profile data must be loaded from disk into
the software. The GPRSPE is designed to both load and save data in the RADAN
format. This is the format used by the GSSI SIR-10B when saving raw radar data to
disk. GPR profiles may be loaded, edited, and saved in this format allowing both
software packages to exchange files.

To load profile data from a file:

Select Load New Image from the File menu in the
Menu Bar. This will initiate the file selection tool.

The tool will allow selection of the appropriate
drive, folder and filename. Select the desired file
and then choose the OK button. GPR files
typically have the extension “dzt.” The GPR
profile will load into both the X and Y registers.
All data in both registers will be overwritten.

The display will be updated
with the new subsurface

profile, gain function, and
vertical scale according to the
current display parameters.
B 08_14.98 Any of the processing
algorithms may be used on
the new data.

FILEZDZT

There are two ways to save profile data to disk. The entire profile may be saved, or
a selected region may be saved as its own independent profile. Saving only a section
allows very large files to be divided into smaller pieces for easier handling and
faster processing. It also allows sections of interest to be filed away independently
for more efficient organization
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To save an entire profile to disk:

Select Save Image from the
File menu in the Menu Bar.
This will initiate the save
image tool. Choose the
desired drive, folder and
filename. Then click OK.

To save only a selection of a profile to disk:

Select Save Selection from the File menu. A dialog box will prompt for selection
of the first point. Press OK. Move the cursor to any point in the profile at the cross-
range location at the start of the section being saved. Click the left mouse button. A
dialog box will prompt for selection of the end point in the selection. Press OK.
Select the end point in the same manner as the start point. The same save image tool
will appear as shown above. Choose a filename and press OK.

Software Exiting

Exiting the GPRSPE is the same as nearly any Windows application. Data should
be saved, as necessary, before exiting. All unsaved profile processing results will be
lost if not saved.

To exit the GPRSPE:

Select Exit from the File menu or select the “X” button in the top right corner of the
environment display.
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CHAPTER 2 View Management

This chapter introduces properties of profile displays in the GPRSPE. Visualization
of profile data requires intelligent display formats to maximize the information
presented. Display options and parameters are explained in the following sections:

Profile Navigation
Image Filters
Color Selection
Scale Format
Zoom

Redraw

Profile Navigation

Many profiles may be longer in cross-range than can be displayed at one time
within the main profile display window. When large profiles are loaded into the
GPRSPE, only a window length of the data is shown at any instance. However, the
entire profile may be viewed by scrolling through the data.

GPR Processing Environment -- User’s Manual
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To navigate the profile view:

To move through a profile in cross-range, simply use the scroll bar at the bottom of
the main profile display window. Click and drag the navigation bar on the scroll bar,
click on either side of the navigation bar, or use the arrow buttons on either side of
the scroll bar. Moving through the profile in no way affects the data. Processing
performed on the profile is performed on the entire profile, not just that which is
currently visible in the main display window.

Image Filters

Communication of information in a profile to the software operator takes place
primarily through one channel: the profile image. It is essential that this image
present the profile data effectively such that important features and qualities of the
subsurface returns may be distinguishable. To further this task, several image
processing routines are available to control display characteristics. Theses options
include:

¢ Signed decibel

¢ Absolute value

¢ Histogram equalization
e Median filter

The display options were not designed to be used alone. They may be used in any
combination to achieve the best results. Access to the routines is efficient, allowing
various combinations to be quickly tried in each situation.

Signed Decibel

Data collected by the GPR may typically range in amplitude over several orders of
magnitude due to the exponential attenuation of the electromagnetic signal during
propagation through the subsurface. This makes visualization of many profiles
difficult, if not impossible, using a linear scale, which distributes the allocated
colors evenly between the lowest and highest values in a data set. Very high values
often cause small values to be indistinguishable when the data is displayed. One
way to often improve the display of such large dynamic ranges is to display the data
in decibels.
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To display in decibel, twenty times the LOGj of the data is calculated. The
displayed dynamic range is, therefore, compressed allowing both high and low
amplitude returns to be seen. The only problem is that the LOG of negative values
does not exist, so the absolute value of the data is typically taken first.
Unfortunately, this removes any information present in the sign of the signal
amplitude. In GPR this may represent significant information to the operator, due
do the alternating sign of the peaks in an electromagnetic waveform. Hence,
discarding the sign of GPR data is not an ideal solution. A better solution is
included in the GPRSPE. The decibel values are calculated as usual; then the points
are given the sign of the corresponding point in the original data. In this way, the
dynamic range is compressed, but sign is preserved.

Signed decibel display mode should be used when all that can be seen in the profile
is the strong response from very shallow objects. In this case, little to nothing may
be seen in most of the profile. Signed decibel mode may make deeper objects
visible. The function may be turned on and off to compare results. Then the most
informative display may be chosen.

To turn Signed dB mode on and off;

The Signed dB mode may be selected and deselected using the dB
button in the Display Options parameters box. Simply click the
mouse on the dB button. The mode may also be toggled using the
dB Display selection in the View menu.

Absolute Value

At times, before or after processing, the magnitude of returns may
prove to be interesting without regard to sign. In such instances, the GPRSPE
provides for absolute value display.

Absolute value display removes the sign of the data before its display. This flips
both negative and positive peaks of the electromagnetic wave returns to the same
side. The colorscale is then adjusted to scale from zero to the maximum magnitude
of the data values, rather than from the minimum data value to the max. At times,
this will demonstrate some significant features in the return. However, the display
mode is often more useful after various processing methods to see a magnitude
response.
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To turn Absolute Value mode on and off:

The Absolute Value mode may be selected and deselected using
the ABS button in the Display Options parameters box. Simply
click the mouse on the ABS button. The mode may also be toggled
using the ABS Display selection in the View menu.

Histogram Equalization

When colors are allocated for the display of data, they are most
often distributed in a linear manner. This means that the colors are
ranked in some order according to some predefined colorscale.
The top color value is assigned to the highest sample value in the data while the
bottom color value is assigned to the lowest sample value in the data. All the colors
between the top and bottom are allotted data values which are evenly distributed
between the highest and the lowest values. The colors are, therefore, allocated
without regard for where the data values are most prevalent within the determined
range. In many situations, a better method will allocate the available colors only in
the ranges where data values exist within the set. Histogram equalization provides
such a method.

Linear color allocation is perfectly acceptable in many instances. In fact, it works
very well, and it provides a linear association between the data value and the
position of the color within the color range. Generally, this linear color association
is more natural or intuitive. However, there are many situations when this method
provides little to no color separation between features of interest within a data set.
For example, suppose there are both a few very high data values and a few very low
data values within a given data set. In this set consider also that a majority of the
data values are within a much smaller range somewhere in the middle of the set,
with no values of data points in the substantial regions between this central group of
points and either the small, high group or the small, low group. In the linear
allocation scheme, colors will be assigned evenly between the highest group and
the lowest group. Many colors will be wasted in the display of the data because they
will be assigned to data values which do not exist in the data set: values between the
middle group and the high or low groups. There will be few of the limited number
of colors available to display the very large middle group of points. These few
colors will be distributed evenly over the important middle set of points, and each
point will be displayed using the color representing a value which is closest to the
actual data value. Small differences in the actual data values, which may represent
significant features in the data, may not be visible because they are mapped to the
same color as a result of the insufficient number of colors available for their display.
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Histogram equalization will allocate the available colors only in the ranges where
data values exist within the set. In this way, all colors will be used to visualize the
data without wasting colors. Before determining where colors should be
distributed, histogram equalization maps out the number of occurrences of each
data value within a given set. It then chooses to assign the colors such that each
color is used an equal number of times in displaying the data. Narrow
congregations of data with many representative points, having small differences
between them, now receive a sufficient number of colors for the mapping of small
differences in value to different colors. The important features may now be visible,
whereas before they might not have been.

Histogram equalization works very well in many instances.
Sometimes, however, it applies too many colors and makes
interpretation difficult. In these cases, normal color assignment is
preferable. Histogram equalization complements the standard
linear allocation very well, and with viewer discretion succeeds in
significantly improving the visibility, and therefore interpretation,
of GPR profiles.

To turn Histogram Equalization mode on and off:

The Histogram Equalization mode may be selected and deselected

using the Hist Eq button in the Display Options parameters box.
Simply click the mouse on the Hist Eq button. The mode may also be toggled using
the Equalize Display selection in the View menu.

Median Filter

On occasion, profile displays contain a significant amount of what is called “salt
and pepper” noise before or after processing. The phenomenon exerts itself as high
valued, outlying points in an image. These points seldom truly represent
meaningful points in a data set and often cloud the image with a grainy appearance
and/or an inappropriate color scaling. One solution to this problem is a median
filter.

Median filters are often used in many image processing applications. They take all
the points within an area around a pixel and return the median of the points as the
pixel’s new value. This effectively removes any outlying points and produces a less
corrupted display.
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The median filter should be used when the image has a grainy
appearance resulting from “salt and pepper” noise or when it is
suspected that a few outlying points are disrupting the color
allocation scheme.

To turn Median Filter mode on and off:

The Absolute Value mode may be selected and deselected using
the Median button in the Display Options parameters box.
Simply click the mouse on the Median button. The mode may also
be toggled using the Median Filter selection in the View menu.

Color Selection

A very important feature of the GPRSPE is the ability to easily choose and modify
the colortable used to display the profile data. Much greater color depth is available
compared to previously used software. Color schemes have also been designed to
emphasize various characteristics of data. Intelligent use of color greatly affects the
visibility of features in GPR data.

The GPRSPE allows selection of a variety of predefined colortables. Each
colortable may cause different features or characteristics of the subsurface to be
more visible. Color selection is quick and easy such that, in each situation, different
colors may be efficiently compared to produce the most beneficial results.

One consideration when choosing a colortable is whether the table is one-sided or
two-side. One-sided tables typically have one color at one extreme and another at
the other extreme. For example, a one-sided colortable may have a linear gradient
between black on one side and white on the other side.

One-sided colortables often represent absolute-valued data very well. Zero maps to
one color while high values map toward the other. Two-sided maps better represent
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data having positive and negative values. Such maps typically have a color, often
black, in the middle with gradients to different colors toward each end.

Positive and negative peaks of the electromagnetic waveform, for example, are
mapped to different colors with a two-sided colortable. Often in GPR processing,
several colortables should be utilized when viewing results. The current colortable
is always displayed with a colorbar in the Display Options control box.

To select a colortable:

" B Oisplay
ABS Display .
¢ Equalize Display Colortables may be chosen under the View menu. Selecting
. :ﬁ;?gm ,| Standard Colors will open a list of the available colortables.
Edit Staridard Color Simply click on the desired table to switch the display to the
ﬁ ii;’f“m new table. Switching colortables is also possible using the

Color Table Tool.

Color Table Tool

Colortables may be selected and customized using the Color Table Tool. The tool
allows improved flexibility in the display of profile data giving the operator the
ability to control how data is visualized. Improved feature recognition can result in
a better interpretation.

To start the Color Table Tool:
dB Display

&B8 Display
Select Edit Standard Color from the View menu. A tool will Ecqualize Display

) : A Modan Fi
appear on the desktop which allows selection and modification MGHATEEIN

of the available colortables. Edit Standard Cokar
Zoom

o Rediaw
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To select a colortable:

-'+ Colov Table Tool .

Simply click the mouse on a
colortable name to choose it. The
name will highlight, and the new table
will be displayed in the colorbar. The
scroll bar on the right of the list will
display more options.

To modify the current colortable:

There are five modifications which can be made to the current colortable:
1. Reversing the colortable
To reverse the colortable, simply select the Reverse button at the bottom left of the

Color Table Tool. This will completely flip the colortable. Results will be shown in
the colorbar.

2. Rotating the colortable

To rotate the colortable, move the mouse pointer on top of the colorbar on the
Color Table Tool. The pointer will change shape.

D rag‘léft mouse button to ratate colartable

21 254

Click and hold the left mouse button, and then drag the mouse to the right or left.
The colors of the colormap will rotate in the direction of mouse movement. When
satisfied with the results, simply release the mouse button.

3. Stretching the top of the colortable

To stretch the top of the colortable, use the Stretch Top slider on the Color Table
Tool. Click and drag the slider bar or use the arrow at each end of the slider to
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adjust the stretching value. The colorbar will change to show modifications as the
colortable is stretched.

4, Stretching the bottom of the colortable

This procedure is identical to stretching the top, except that the Stretch Bottom
slider on the Color Table Tool should be used.

5. Undoing the changes

The colortable may be reverted back to its original form using the Undo button at
the bottom center of the Color Table Tool or by reloading the original table by
selecting it in the color table list.

To exit the Color Table Tool:

To exit the tool, simply click on the Dismiss button at the bottom right of the Color
Table Tool.

Scale Format

The vertical scale of the profile display may assume several units: sample number,
time, or depth estimate. Each of these formats serve to present operators with
information they may need from a GPR survey.

To change the down-range scale:

Changing the down-range scale requires simply clicking on the appropriate button
of choice in the Down Range Scale Options box on the GUI. The scale displayed
in the vertical axis window will change to the appropriate format.

Depth estimation is based upon a user supplied estimate of the average dielectric
constant of the subsurface medium. The dielectric estimate must be set by the
operator using the Dielectric Estimate slider in the Down Range Scale Options
control box.
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To change the dielectric estimate for depth calculation:

To change the dielectric estimate click and drag the slider bar on the Dielectric
Estimate slider, or click on the arrows on either side of the slider. The depth scale
will change with each modification of the dielectric constant estimate.

Zoom

The Zoom function may be used for a closer look at a region of the profile.

To use the Zoom function:

To zoom in on a region of a profile, click on [Z00M]. A dialog box will prompt
for a zoom center point. Select OK and then click in the profile display at the
location of interest. A new zoom window will appear with a close up display of the
selected region. Zoom may be used multiple times; each time a new zoom window
is created.

To destroy zoom windows:

To destroy zoom windows, click the X button in the upper right corner of the
windows, as is the procedure for closing most window applications.

Redraw

On occasion it may be desirable to refresh the profile display. This is accomplished
using the Redraw function. Redraw re-displays the GPR data in the main display.
This will effectively remove temporary annotations placed in the display using the
annotation buttons. This does not apply to the Post Processing Editor display or
any annotation applied therein.

To redraw the display:

To redraw the display, simply click on in the Button Bar.
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Profile Editing

This chapter introduces profile editing concepts pertinent to use of the GPRSPE.
Profile editing helps with data management tasks, speeds processing of data, and
prepares profile data for processing techniques. Editing methods discussed in the
following sections include:

¢ Cropping Data

¢ Deleting Data

e Removing Gain

e Modifying Gain

¢ Sketching Objects

Cropping Data

Processing time is directly related to the amount of data to process. Less data means
quicker processing. For this reason, efficiency of GPR analysis may be improved by
processing only important sections of GPR data sets. Cropping out only the section
of interest is one method of reducing the amount of data to process.
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To crop out a section of data:

To crop out a region of data, select Crop from the Edit
menu. A dialog box will appear prompting for the first cross-
range location of the region to crop. Click the OK button and
then click in the profile display at any vertical point, having
the desired cross-range value, in the profile for the starting point of the region. A
second dialog box will then appear prompting for selection of the second cross-
range value. Once again, click OK. The scroll bar may be used to move through the
profile. Click in the profile display to select the second cross-range value, for the
end of the desired region. The display will update to show only the cropped section
of the profile. At times the scroll bar may need to be moved for it to reset, so the
profile can be seen.

Deleting Data

Deleting unimportant sections of GPR data is another way to reduce the amount of
data to process. Once again, this is very important for reduction of processing time
and the subsequent improved efficiency of GPR analysis.

To delete a section of data:

Deleting a section of data is very similar to the procedure for cropping out a
section. Select Delete Section from the Edit menu. A dialog box will appear
prompting for the first cross-range location of the range to delete. Click the OK
button in the profile display at the start of the range. A second dialog box will
prompt for selection of the end of the range. Click OK. The scroll bar may be used
to move through the data, and then select the end of the range to delete. The display
will update to reflect the profile with the undesired range removed. At times the
scroll bar may need to be moved for it to reset and show the profile correctly.

Removing Gain

Many times the gain function applied to the GPR data by the radar is not desired for
processing. Algorithms often process based upon the natural characteristics of the
returned waveform or the subsurface features. An arbitrary gain function is in no
way correlated to either of these qualities, and is therefore undesirable. The gain
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function often magnifies system noise to an unsatisfactory level as well. The
GPRSPE will easily remove the gain function that was applied to the data by the
radar. The necessary information to perform this task is retrieved from the header
information written in the data file by the radar system.

To remove the gain function:

To remove the gain function, simply select Remove Gain Function from the Edit
menu. The gain function will be removed. The profile display and the gain function
display will be updated to demonstrate the modified data and gain function.

Modifying Gain

Sometimes applying a gain function to profile data will make deeper objects
visible. As long as the function does not disturb other processing, a gain function
will often amplify small returns from subsurface features which have been
attenuated by long travel distances in the ground. Careful use allows gain functions
to increase visibility and benefit GPR analysis.

Modifying the gain function in the GPRSPE utilizes a graphical tool specifically
designed to be compatible with gain functions used in the radar system. This allows
compatibility between the GPRSPE and formerly used GSSI software. The gain
function may contain up to eight points. The value of the gain is linearly
interpolated between the gain values at the points. Gain values at each point are set
using the graphical tool. The new gain function is stored in the data file header
when the profile is saved.

To modify the gain function:

To initiate the Modify Gain Function tool, select
Modify Gain Function from the Edit menu. This
will begin the graphical tool which appears on the
desktop. The tool will set the number of gain
points in the gain function. As many as eight
points may be used. Set the number of points by
dragging the slider bar, by using the arrow buttons
on either side of the slider, or by clicking in the
edit box and typing the desired number from the keyboard. Once the number of
points has been set, select the Proceed button at the bottom left of the tool.
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The tool will be replaced by a second graphical tool
which will allow the gain values at each gain point to
be set. A control box on the left of the tool contains
buttons for each gain point. The number of buttons
will refiect the number of gain points selected
previously. The tool slider sets the value of the
currently selected gain point while the graphic
display shows the entire gain function.

To set the gain function:

Setting the gain function involves setting the gain value for each of the gain points.
The values between gain points will be linearly interpolated. Select a gain point to
modify by clicking on a gain point button in the upper left control box of the tool.
The buttons are numbered according to the gain point number. Once a point has
been selected, its current value will be shown by the slider control. Use the slider to
set the gain point value by dragging the slider bar, by using the arrow buttons on
either side of the slider, or by clicking in the edit box and typing the value using the
keyboard. The graph of the gain function will change to illustrate the gain point
modification. Notice that the scale must often adjust. Repeat the procedure, setting
each gain point. Once the desired gain function is created, select the Proceed
button at the bottom left of the tool. The previous gain function will first be
removed from the data, and then the new gain function will be applied. The display
will be updated to show the modified profile data, and the gain function display will
show the new gain function.

NOTE: Each time the gain function is modified, it is not applied on top of the pre-
vious gain function. The previous gain function is removed first, such that the new
function is applied to the unamplified data.

Sketching Objects

Functions have been added to the GPRSPE to allow temporary sketching of objects
in the profile display. These objects include: text, lines, boxes, and circles. The
objects in no way affect the data and are simply meant to serve as temporary
markings in the profile display. Such functions may be useful during profile
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analysis. The markings are removed anytime the display is redrawn. However, they
will be permanently present in the Post-Processing Editor if they were visible in the
display when the editor was initiated.

To sketch objects in the profile display:

The sketching functions may be selected using buttons on the Button Bar. The
functions operate in a similar fashion to most graphic design applications and
Windows programs.

-Text layout tool. Click the button. A window will appear and prompt for the
location of the text. Press OK. Select text location in the profile display. A text
input window will appear. Enter text in input box. Press OK.

-Line tool. Click the button. A window will appear and prompt for the starting
point of the line. Press OK. Click the left mouse button at the starting point of the
desired line. A second window will appear and prompt for the ending point of the
line. Press OK. Move the mouse to the endpoint of the line, and then click the
mouse button. '

-Rectangle tool. Click the button. A window will appear and prompt for the
starting corner of the box. Press OK. Click the left mouse button at the starting
point of the desired box. A second window will appear and prompt for the ending
corner of the box. Press OK. Move the mouse to the end corner of the box, and
click the mouse button.

.M -Circle tool. Click the button. A window will appear and prompt for the center
of the circle. Press OK. Click the left mouse button at the starting point of the
desired circle. A second window will appear and prompt for a point on the circle.
Press OK. Move the mouse to a point on the desired circle and click the mouse
button.

To clear the sketched objects from the profile display:

Simply press Fiﬂld or select Redraw from the View menu. This will

redraw the main profile display window. Any time the profile display is redrawn the
sketched objects are removed. Most processing routines redraw the display to show
results and, therefore, erase any sketched objects.
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CHAPTER 4

Processing

This chapter introduces the GPR processing capacity of the GPRSPE. Processing
concepts are discussed, and algorithm use is illustrated. GPRSPE functions to be
covered include:

Migration
Thresholding
Background Removal
Adaptive Inversion
Impulse Forcing

Multiresolution Analysis

Migration

Migration is the process of focusing the hyperbolic responses of point targets in
GPR profiles to points with the goal of providing a more meaningful representation
of the subsurface for interpretation. Fixing the problem, however, is not a simple
task. Several difficulties arise. First, not all responses are from point targets and do
not, therefore, have a nice hyperbolic shape. Few prior assumptions can be made
about the subsurface to remedy this problem. Second, the inconsistent cross-range
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sample interval corrupts the shape of the responses, so matching hyperbolas to the
responses can sometimes prove difficult. Third, the hyperbolic shape depends on
the velocity of the electromagnetic wave in the medium, which is not constant for
most situations. So, the responses may be distorted by gradients in the dielectric
constant, which cannot be determined to a sufficient extent to correct the problem.
Finally, interference from multiple nearby targets creates a much more complex
response. With all this said, the possibility of migration of GPR returns sounds
nearly impossible; but, in many situations, it may in fact be helpful. Typical use of
the radar often involves locating utilities such as buried pipes and cables, or rebar--
all of which respond as point targets in a perpendicular cross-section. The dielectric
may vary a significant amount between targets located in different sections of a
profile, but it will often be constant enough in the immediate area around a specific
target. If the data is carefully collected such that the cross-range sample rate
maintains a relatively constant sample interval, then migration can be of use for
improving the interpretation and cross-range localization of the object of interest,
particularly of point targets.

def’n: Migration - focusing the hyperbolic responses of point targets to more
point-like response for improved recognition and localization.

def’n: Interference - distorted response due to overlap between responses from
multiple targets which have added together making the return from each individual
object less recognizable.

Two migration methods have been found to be beneficial and have been coded for
use in the processing software:

¢ Simple Migration
e FFT Migration

Simple Migration

It can be shown that the hyperbolic shape for a point target will be a specific shape
for a given target depth, medium dielectric constant, and radar antenna beamwidth.
The simple migration algorithm uses the physical geometry of the radar system and
the resulting hyperbola associated with an un-migrated point target in a GPR profile
image to migrate GPR data.

The algorithm uses the assumption that the target is a point object with sufficient
returned energy to be discernible from the profile background, where no significant
level returns were detected. With this assumption the algorithm thresholds the
amplitude data from the GPR and only processes significantly high responses
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which are considered to be likely candidates for point targets. If the GPR image
pixel is above the threshold, the hyperbolic shape is calculated for the specified
GPR beamwidth, medium dielectric, and depth of the target. The energy contained
along the hyperbola is then integrated or summed to create the new value for the
pixel at the hyperbola’s apex. This effectively collapses the hyperbolic shape to a
more point-like object, as is more appropriate for interpretation. The process is
repeated for each pixel in the profile which meets the threshold requirement.
Focusing the point targets also narrows the extent of the target response in cross-
range, providing a more precise location of the object.

To migrate a profile using simple migration:

To migrate a profile select Simple s i
Migration from the Process menu. A | Set Simple Migration Parameters
graphical parameter selection tool will
appear on the desktop. This tool sets all
the parameters required for using the
Simple Migration algorithm.

Four parameters must be set for operation
of the algorithm. Each parameter is
controlled using a slider on the graphical
tool. Set each parameter to the desired
value by clicking and dragging the slider
bar, by using the arrow buttons on either
side of the slider, or by clicking in the edit
box and typing the value from the
keyboard. The four parameters which
must be set are:

1. Threshold down from maximum

This threshold determines the cutoff in dB below the maximum sample value for
processing. The algorithm will ignore all points with lower amplitude than this
threshold. It is assumed that significant returns have a relatively high amplitude. For
this reason, the routine throws out all points considered too low to be a true return,
based upon the set threshold. A lower threshold includes more points and,
therefore, takes longer to process. Conversely, a higher threshold takes a shorter
time to process.

GPR Processing Environment -- User’s Manual 37



Processing

2. Meters per scan in cross-range

This parameter is the cross-range sample interval of the radar. The radar is
sampling as the antenna is traversed across an area. The average distance between
each sample is the sample interval. To calculate the sample interval, markers must
be placed in the data at regular intervals. These markers appear in the profile
display and allow the operator to estimate distance in cross-range. The horizontal
axis of the profile display shows the cross-range sample, or trace, number. To
calculate the cross-range sample interval, simply divide the number of meters
between markers in cross-range by the number of samples between the same
markers. For a more accurate estimate the distance and samples over several marker
lengths should be used. Using multiple marker lengths for the calculation is highly
recommended.

3. E_r of Medium

This parameter is the average dielectric constant of the subsurface medium. The
dielectric constant may be known from additional material analysis. It may also be
estimated based upon operator experience and material characteristics. The profile
may also be reprocessed through a range of dielectrics if the constant is not
accurately known. The parameter value which produces the best results provides an
estimate of the subsurface medium dielectric constant.

4. 1/2 angle beamwidth

The half-angle beamwidth specifies in degrees how far out from directly below the
radar antenna can see. It is one-half of the beamwidth of the antenna. This
parameter is used in the calculation of the hyperbolic shape for matching with the
profile data. A larger beamwidth means the radar could see a target sooner; the
response would, therefore, be larger. This requires a longer computation time.
Smaller beamwidths calculate faster. The half-angle beamwidth should typically be
set in the 30-50 degree range.

Once the parameters have been set, processing may be initiated by selecting the
Process button at the bottom left of the tool.

To estimate the dielectric constant using simple migration:

An estimate of the dielectric constant may be found by migrating a known point
target response in a profile using a range of values for the dielectric parameter
required by the Simple Migration algorithm. The parameter value which produces
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the best results may be considered an estimate of the dielectric constant of the
subsurface medium surrounding the point target.

FET Migration

“FFT” is an acronym for Fast Fourier Transform, which is a very fast algorithm that
transforms a signal from the time domain to the frequency domain. FFT Migration
is, therefore, a migration method using the Fast Fourier Transform. This method of
profile migration was originally developed for seismic data processing. It has also
been used for Synthetic Aperture Radar (SAR) applications, which are similar in
nature to the geophysical GPR application. The algorithm takes advantage of
relationships between traveling wavefronts in the frequency domain.

FFT Migration processing transforms the time-domain profile into the 2-D
frequency domain. It is able to use the Fast Fourier Transform for this conversion,
which results in a remarkably efficient algorithm and extremely fast operation.
Once in the frequency domain, a spatial transformation is executed to perform the
required focusing, and then the Inverse Fast Fourier Transform is performed to
return the migrated GPR profile.

To migrate a profile using FET migration:

To migrate a profile select FFT Migration from the
Process menu. A graphical parameter selection tool
will appear on the desktop. This tool sets all the
parameters required for using the FFT Migration
algorithm.

i F-K Migration

Two parameters must be set for operation of the
algorithm. Each parameter is controlled using a slider
on the graphical tool. Set each parameter to the
desired value by clicking and dragging the slider bar,
by using the arrow buttons on either side of the slider,
or by clicking in the edit box and typing the value
from the keyboard. The two parameters which must
be set are:

1. Meters per scan in cross-range
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This parameter is the cross-range sample interval of the radar. The radar is
sampling as the antenna is traversed across an area. The average distance between
each sample is the sample interval. To calculate the sample interval, markers must
be placed in the data at regular intervals. These markers appear in the profile
display and allow the operator to estimate distance in cross-range. The horizontal
axis of the profile display shows the cross-range sample, or trace, number. To
calculate the cross-range sample interval, simply divide the number of meters
between markers in cross-range by the number of samples between the same
markers. For a more accurate estimate the distance and samples over several marker
lengths should be used. Using multiple marker lengths for the calculation is highly
recommended.

2. E_r of Medium

This parameter is the average dielectric constant of the subsurface medium. The
dielectric constant may be known from additional material analysis. It may also be
estimated based upon operator experience and material characteristics. The profile
may also be reprocessed through a range of dielectrics if the constant is not
accurately known. The parameter value which produces the best results provides an
estimate of the subsurface medium dielectric constant.

Once the parameters have been set, processing may be initiated by selecting the
Process button at the bottom left of the tool.

To estimate the dielectric constant using FFT migration:

An estimate of the dielectric constant may be found by migrating a known point
target response in a profile using a range of values for the dielectric parameter
required by the FFT Migration algorithm. The parameter value which produces the
best results may be considered an estimate of the dielectric constant of the
subsurface medium surrounding the point target.

Thresholding

Electromagnetic returns from subsurface objects are often of significantly higher
magnitude than the magnitude of background noise, particularly for near-surface
objects. Many times interpretation of GPR profiles benefits from simply zeroing out
data values below some threshold, effectively removing unwanted clutter from
background noise.
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def’n: Background Noise - unwanted signal received and measured by the radar
which often clutters a profile display. Often a result of random thermal noise
within the radar system or receive electromagnetic radiation from other electro-
magnetic sources.

To threshold GPR data:

To threshold a profile select Threshold from the
Process menu. A graphical parameter selection
tool will appear on the desktop. This tool sets the
parameter required for using the Threshold
algorithm.

Only one parameter must be set for operation of

the algorithm. The parameter is controlled using a slider on the graphical tool. Set
the parameter to the desired value by clicking and dragging the slider bar, by using
the arrow buttons on either side of the slider, or by clicking in the edit box and
typing the value from the keyboard. The only parameter which must be set is the
desired threshold. The threshold is specified in decibels below the maximum data
value. All data points whose magnitude is less than the threshold will be set equal
to zero.

Once the threshold has been set, processing may be initiated by selecting the
Process button at the bottom left of the tool.

Background Removal

Horizontal bands frequently obscure more important information in a GPR profile.
These bands sometimes result from ringing of the antenna, ground coupling effects,
or the response from some artifact maintaining a constant distance from a poorly
shielded antenna. Routines have been written which remove banding in a response
profile. The algorithms assume that any response which is constant for the entire
profile, or for a user selected range, is useless information. The algorithms,
therefore, average the traces over the given cross-range and subtract the result from
each trace in the profile. This procedure effectively removes the banding and quite
often reveals pertinent data. The routine must be used with caution due the
possibility of removing responses from anomalies with significant horizontal
extent.
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To automatically remove background clutter:

To remove the background automatically, select Remove Background Auto from
the Process menu. The algorithm will process the data and the display will be
updated to show the modified profile without additional input or parameter
selection.

To remove background clutter using a selected range:

To remove the background with a manually selected range, select Remove
Background Manual from the Process menu. A dialog box will appear prompting
for the start of the range. Select OK and then click the mouse pointer in the profile
display at any point with the desired cross-range value for the starting point. A
second dialog box will appear prompting for input of the range ending point. Click
OK and then select the range endpoint by clicking the mouse in the profile display
at the appropriate cross-range. Processing will then begin averaging the traces
within the selected range and subtracting the average values from every trace in the
profile.

Adaptive Inversion

One way of considering the GPR subsurface imaging problem is to interpret the
ground as a filter. The source waveform from the radar would be the input to the
filter, and the received signal would be the output from the filter. This filter could be
generalized as a series of impulses, having an impulse at each interface between
layers of differing dielectrics. It would be easier to interpret a profile if the profile
were more like this original subsurface filter, having narrow peaks at each layer
interface.

What is seen as the output in a GPR profile is the result of the source waveform
being filtered by, or convolved with, the ground response.

def’n: Convolution - the mathematical process of filtering a time series or signal
with another signal/filter.

This response appears similar to a “mexican hat” waveform at each interface. The
“mexican hat” has a high main lobe and two smaller, negative sidelobes. One
reason GPR profiles are difficult to interpret is that each interface returns a
waveform with multiple lobes of alternating sign. Ideally, it would be easier to
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interpret a profile if the profile were more like the original subsurface response,
which consists of one high amplitude, narrow peak at each interface. The desired
profile, the impulse response of the ground, can be attained by separating, or
mathematically speaking, deconvolving the source waveform from the returned
response.

def’n: Deconvolution - the mathematical process of separating one signal/filter
from the output signal given the other signal/filter.

However, this filtering cannot be done when a ground coupled radar is used because
the input signal is a function of the ground coupling and, therefore, is not accurately
known or measurable. Resolving this problem calls for more creative methods. One
such method is known as adaptive inversion, or blind deconvolution.

def’n: Blind Deconvolution - Separating two signals given only the combined sig-
nal. Assumptions must be made about the characteristics of the two signals which
will allow separation.

The deconvolution procedure is considered “blind” because it must separate both
signals without knowing either one of them. In order to do this, one of the signals is
modeled as a white noise process, while the other is modeled as linearly
predictable. Both the additive noise and the subsurface impulse response may be
modeled as a white noise process due to their random nature; no combination of
previous values of the samples tells anything about the next samples. The input
signal, however, may be approximately modeled as the impulse response of an all-
pole, minimum-phase filter. This means that each sample value is a linear
combination of previous samples, and the next sample may be effectively predicted
from the current sample and previous ones. In summary, the input signal may be
predicted, with an appropriate filter, from current and previous samples while the
ground response and additive noise may not. This assumption is very beneficial and
allows for an estimated deconvolution of the two signals. To perform this blind
deconvolution, an adaptive filter is utilized.

def’n: Adaptive Filter - a filter which is designed to change itself over time to min-
imize the error between its output and some desired response.

The filter is designed to predict the next value of each sample in a trace as it filters
the trace. After each prediction, the error between the predicted value of the trace
and the actual value is used to modify the values of the filter such that it is more
capable of predicting the next value. Hence, the filter adapts to minimize the error
between what it predicts as the next sample in a trace and the measured sample. The
filter gets closer and closer to being able to predict the next value until it is
predicting as well as possible. At this point, the filter is said to have “converged” to
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an estimate of the model for the input signal. If the adaptive filter is now predicting
the next value of the input, then the error between the predicted value and the actual
value must be that which it cannot predict in the measured response: the noise-like
response of the ground and the additive noise in the system. This error, therefore, is
an estimate of the impulsive subsurface filter having high, narrow responses at each
layer interface. Many assumptions were made to produce the blind deconvolution
algorithm. The results of the algorithm are only as good as the assumptions which
are made. For this reason, it is easy to understand why an ideal ground response
profile is not achieved. In fact, the assumptions in no way accounted for the
hyperbolic integration problem mentioned previously. However, the assumptions
are good enough to enable the blind deconvolution algorithm to benefit
interpretation of GPR profiles. The algorithm is capable of collapsing some of the
responses, which are widespread in the down-range time-domain, into denser
clusters of information. Recognition of true responses from objects is significantly
improved in many profiles using the blind deconvolution algorithm.

To inverse the GPR profile:

For adaptive inversion of the profile, select Inverse -
Adaptive from the Process menu. A graphical
parameter selection tool will appear on the desktop.
This tool sets all the parameters required for using the
Adaptive Inversion algorithm.

Two parameters must be set for operation of the
algorithm. Each parameter is controlled using a slider
on the graphical tool. Set each parameter to the
desired value by clicking and dragging the slider bar,

by using the arrow buttons on either side of the slider, or by clicking in the edit box

and typing the value from the keyboard. The two parameters which must be set are:

1. Filter Order

The filter order is the number of previous samples used by the adaptive filter to
predict the next sample. For every additional sample used in the prediction, the
order of the system increases. This increases the computation required for the
prediction; but, more importantly, it greatly increases the computation required to
adapt the filter. The speed of the algorithm is inversely proportional to the filter
order.
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2. Adaptation Rate

This parameter determines how fast the adaptive filter changes itself to minimize
the prediction error. If the adaptation rate is set too low, the filter will not reach an
acceptable model of the input electromagnetic waveform fast enough to perform
the blind deconvolution appropriately. If the parameter is set too high, the filter may
change too quickly and become unstable.

Once the parameters have been set, processing may be initiated by selecting the
Process button at the bottom left of the tool.

Impulse Forcing

Profiles are easily cluttered by wide bands of color which exist in the display
because of the wide crests and troughs of the electromagnetic source waveform, the
wide beamwidth response pattern, and the interference between neighboring
objects. The Impulse Forcing algorithm has been designed to alleviate some of the
visual overload associated with these many complex phenomena.

The Impulse Forcing algorithm filters each trace in a profile and returns an impulse,
weighted by the original sample value for every sample that meets the following
criterion: 1. The sample must be the highest valued sample within a sliding window
of a user specified width centered around the sample, and 2. The sample must be a
certain percentage, determined by a user specified threshold, higher than the
standard deviation of all the samples within the sliding window. This algorithm
attempts to replace broadly shaped returns with fine lines at the positive and
negative peaks subject to a specified window size. It also attempts to ignore low
amplitude peaks which are probably not from legitimate returns by comparing their
value with the standard deviation within the sliding window. The peak must be of
significant size compared to the surrounding data samples to register as an impulse.
The Impulse Forcing procedure emphasizes the slopes and curvatures of responses
within a profile and presents some insight into subsurface features. The algorithm
may be used on the unprocessed profile and can also be informative when applied
after the Blind Deconvolution process. Typically, the results of this algorithm are
best viewed in signed decibel mode without histogram equalization.
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To force impulse returns in a GPR profile:

To run the Force Impulse algorithm, select Force
Impulse from the Process menu. A graphical
parameter selection tool will appear on the desktop.
This tool sets all the parameters required for using the
Force Impulse algorithm.

Force Impulse

Two parameters must be set for operation of the
algorithm. Each parameter is controlled using a slider
on the graphical tool. Set each parameter to the desired
value by clicking and dragging the slider bar, by using
the arrow buttons on either side of the slider, or by clicking in the edit box and
typing the value from the keyboard. The two parameters which must be set are:

1. Threshold

The threshold parameter determines what percentage of the standard deviation the
sample value must be above to be considered for an impulse point.

2. Window Size

This parameter sets the width of the window for the algorithm. Impulses will not be

placed in the data any closer than one window width. The window width should not
be set smaller than the minimum desired resolution.

Once the parameters have been set, processing may be initiated by selecting the
Process button at the bottom left of the tool.

Multiresolution Analysis

GPR signals do not readily lend themselves to typical frequency analysis. The
measured waveforms are not stationary and, therefore, have a frequency content
that varies with time. Fourier analysis determines the frequency content of the
entire signal, but fails to provide any time information content. This is the exact
dual to the original measured time series providing only time information, but no
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frequency information content. One possible solution to many non-stationary signal
processing applications involves a relatively new concept known as multiresolution
analysis using the wavelet transform.

def’n: Multiresolution Analysis - study of a signal by decomposition of its time
series into a range of resolutions using the Wavelet Transform.

def’n: Wavelet Transform - maps the correlation between a signal and a wavelet
function verses scale/resolution and time.

The underlying principle in Fourier analysis is a comparison of the signal of interest
with cosine functions of varying frequencies. High correlation between the signal
and a particular frequency indicates the presence of that frequency in the waveform.
In this manner, a signal may be dissected into the frequency components, of which
it is composed. Cosine functions are of infinite extent, causing time to be absent in
the frequency decomposition. The wavelet transform uses basis functions other
than cosines in the signal decomposition. These basis functions, called wavelets,
are finite in extent and have a very narrow frequency content. In frequency analysis,
the signal of interest is compared to cosines of varying frequency. In wavelet
analysis, the signal is compared to wavelets of varying scales. The wavelet scale is
a variable in the wavelet function which determines the frequency and extent of the
waveform, just like frequency in the cosine function does to the cosine waveform.
The wavelet waveform changes, based upon its scale, from low frequency with long
extent to high frequency with short extent. Therefore, because the wavelet basis
functions have both frequency and finite extent, the final wavelet transform contains
both time and frequency information. This time-frequency component is called
resolution. A signal may be decomposed into its multiple resolutions by
comparison with wavelets through a range of scales--hence the notion of
“multiresolution analysis”. Similar to frequency filtering, where only the important
frequencies in a signal are kept; once a signal has been decomposed using the
wavelet transform, the desirable resolutions may be kept while the unimportant are
discarded. In this way, features in the signal may be selectively chosen based upon
their resolution. Such processing may be applied to measured GPR returns and
proves to be beneficial in enhancing the returns from artifacts while reducing clutter
in the display of GPR profiles. Subsurface features are, therefore, more easily
recognized, and interpretation is significantly improved.

The Multiresolution Analysis algorithm provides such wavelet based processing
and a graphical tool that allows user selection of the most beneficial scale, as well
as a choice of several wavelet basis functions which are provided. Multiresolution
analysis provides excellent results in many situations and is quite fast due to the
Fast Fourier Transform method used to compute the wavelet transform.
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To use multiresolution analysis:

Wavelet Analysis Tool

To start the Wavelet Analysis Tool, select
Multiresolution from the Process menu. The
graphical parameter selection tool will appear
on the desktop. This tool sets all the parameters
required for using multiresolution analysis.

Two parameters must be set for operation of the
algorithm. The two parameters which must be
set are:

1. Wavelet Function

The first parameter is simply selection of which wavelet function will be used for
the analysis. Three options are available: Morlet, Derivative Of Gaussian (D.0.G.),
and Paul. The wavelet function is selected using the buttons in the control box at the
left side of the graphical tool. Simply click the mouse on the button by the function
of choice. The waveform display will update to show the appropriate function.

2. Wavelet Scale

The second parameter which must be set is the scale of the selected wavelet
function. This parameter is controlled using a stider on the graphical tool. Set the
scale to the desired value by clicking and dragging the slider bar, by using the arrow
buttons on either side of the slider, or by clicking in the edit box and typing the
value from the keyboard. As the scale is changed, the waveform display update to
show modifications.

Once the parameters have been set, processing may be initiated by selecting the

Process button at the bottom left of the tool. The main profile display will update to
show the processed profile, which is actually the magnitude of the unprocessed
image at the selected scale. Notice that the Wavelet Analysis Tool will not
disappear. Many times, several wavelet scales. may need to be tried before the most
beneficial scale is found. For this reason, the tool does not close. The parameters
may be adjusted, and Process may be selected again to re-process the original
image. After some number of iterations provide an acceptable result, select the
Done button at the bottom right of the tool. This will close the Wavelet Analysis
Tool and leave the processed profile data as the current data set in Register X. Or, if
no results were found to be acceptable, revert back to the original unprocessed
profile by selecting the Cancel button at the bottom of the tool. This will close the
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Wavelet Analysis Tool and return the original unprocessed profile to the display and
the current data set in Register X.
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CHAPTER 5

Post Processing

This chapter discusses the GPRSPE Post-Processing Tool. The Post-Processing
Tool is used when GPR profile processing has been completed to annotate results,
save annotated images, export images for use in graphic design software, and for
additional viewing features. Topic to be covered include:

e Basics
¢ View Management
e Annotation

¢ Input/Output

Basics

The GPRSPE Post-Processing Tool is designed to handle many common after-
processing tasks. Concepts covered in this section include:

¢ Tool initialization
¢ Tool display features
¢ Menu operation

* Tool exiting
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Tool Initialization

Starting Post-Processing Tool may be accomplished in two ways:

1. Select View/Annotate/Print from the File menu.

Starting the tool will import the current profile display window image and the
vertical scale, as they are currently seen, into the Post-Processing Tool. Only the
width of the profile display window will be imported, larger profiles will be
cropped by the profile window width and location. The tool may be started multiple
times. Each time a new multiple of the tool will appear.

2. Select the button on the Button Bar.
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Tool Display Features

The tool display contains multiple regions for image display, system feedback and
environment control.

1. Image Display
The image display window is the large main window where the profile image is

displayed. Scroll bars on the right and bottom sides allow navigation through the
image, which is often larger than the size of the display window.
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2. Command Feedback Display

The tool provides feedback and instructions for each procedure in a text box at the
bottom of the tool.

3. Display Properties Control
A control box for display properties allows several parameters to be set including:
automatic redraw, brightness, and contrast.

4. Zoom Control

A control box on the left side of the tool allows the zoom factor to be modified.

5. Selected Data Display Control

A selected range of data may be viewed in a zoom window. Control of this feature,
including the zoom factor, has its own control box at the left of the tool.

6. Button Bar

The tool has a Button Bar for control of many of the tool functions.

7. Menu Bar

The tool has a standard menu bar, like all Windows applications, for control over
most of the tool features and functions.

Menu Operation

Most of the tool operations may be initiated through use of the menus found in the
Menu Bar. The operations are divided into appropriate categories so that desired
functions may be located intuitively. Operation of the menus is identical to that of
the main GPRSPE environment.
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Tool Exiting

Exiting the Post-Processing Tool is the same as nearly any Windows application.
Data should be saved, necessary, before exiting. All unsaved profile processing
results will be lost if not saved.

To exit the Post-Processing Tool:

Select Exit from the File menu or select the “X” button in the top right corner of the
environment display. Since multiple tools may be open at any one time, make sure
this procedure is only performed on the individual tools which need to be closed.

View Management

This section discusses properties and options of the tool image display including:

e Image Navigation

¢ Display Parameters
e Zoom Options
Profile/Slice Display

Image Navigation

Many images in the tool may be larger than can be displayed at one time within the
display window. However, the entire image may be viewed by scrolling through the
data.

To navigate the image view:

To move through an image, simply use the scroll bar at the bottom or right side of
the image display window. Click and drag the navigation bar on the scroll bar, click
on either side of the navigation bar, or use the arrow buttons on either side of the
scroll bar. The image in the display will move as the scroll bars are modified.
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Display Parameters
Several features of the display may be modified using a control box on the tool.
1. Auto redraw

This option controls whether the display redraws itself when

changes are made. Simply click on the button to toggle this
feature on and off.

2. Brightness

The brightness of the image display may be modified in the
tool. Adjust the slider value till the displayed image is
satisfactory.

3. Contrast
The contrast of the image display may also be changed. Once

again, simply adjust the slider till the displayed results are
acceptable.

4. View Attributes

Several view attributes may be modified
by selecting View Attributes... from the
Attributes menu.

¢ Image Order - sets whether the image
is flipped vertically. To change, click
on the current setting box, and a list
will drop down. Select the desired
option.

o Scale Image Values - determines
whether the pixel values are scaled to
a modified range of colors. In the Post-Processing Tool, twenty colors in the
color scale are set to special plotting colors and reserve at the bottom of the
scale. So, the colorscale is squeezed from 0-255 to 20-255. This makes little
noticeable difference in the display. When Scale Image Values is set, the pixel
values are scale to fit the modified colorscale. This makes the image look the
same as it does in the main environment. This scaling may, however, be turned
off or set to scale to a different range. The range may be changed using the slid-
ers. Typically, this option should not be modified.
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¢ Accept New Variables - used for additional functions not required for this appli-
cation.

Zoom Options

Two different control boxes on the tool control zoom mechanisms. The zoom factor
may be set for the both typical image display and for a separate display window for
a selected range of data.

To change the main display zoom factor:

In the zoom control box, click the mouse on the current
zoom setting box.

A list will drop down. Select the new zoom factor. The display will
update.

To change the selected data zoom factor:

In the selected data zoom control box, turn on the zoom by selecting
the Magnify Selected Data button. A new window will appear for
displaying the magnified data region. Then click the mouse on the
current zoom setting box. A list will drop down. Select the new zoom
factor. The magnified data will be displayed in the new window.

To select a data range:

There are two types of data ranges that can be selected: a typical rectangular range,
and an irregularly shaped range. Buttons on the Button Bar start these two
operations.

- starts the regular, rectangular region selection. Click the button to begin, and

then click and hold the left mouse button in the image display. Drag the mouse to
define a region. Release the mouse button. The selected region will be highlighted.
To deselect the region hold down the SHIFT key and press the left mouse button.
Statistical data is provided in the Command Feedback Display for the selected
rectangular region.
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- starts the irregular shaped region selection. Click the button to begin. Click

and hold the left mouse button in the image display. Drag the mouse to encompass
the desired region, and then release the mouse button. The region will be
highlighted. To deselect the region hold down the SHIFT key and press the left
mouse button. Statistical data is not provided for irregularly shaped regions.

Both regular and irregular selection modes may also be initiated using the Data
Select and Irregular Data Select options respectively in the Edit menu.

Profile/Slice Display

The GPR image pixel values in the Post-Processing Tool may be viewed along any
line using three similar functions. The functions display a plot of a slice of the
image in a separate window. Buttons in the Button Bar initiate the three slice
display functions.

i -starts the Endpoint Profile Slice display. Click the button to begin. A new

slice display window will appear on the desktop. Move the mouse to the image
display. Click and hold the left mouse button at a starting point, and then drag the
mouse. A line will be shown in the display from the starting point to the current
mouse position. In the slice display window, a plot of the image amplitude along
the line will be displayed. When finished, release the mouse button. To remove the
slice display window, click the Dismiss button in the window.

- starts the Row Profile Slice Display. Click the button to begin. A new slice

display window will appear on the desktop. Move the mouse to the image display.
Click in the image at a starting point. In the slice display window, a plot of the
image amplitude along the row of the starting point will be displayed. Dragging the
mouse in the image will cause a dynamic display of each row as the mouse is
moved. When finished, release the mouse button. To remove the slice display
window, click the Dismiss button in the window.

- starts the Column Profile Slice Display. Click the button to begin. A new

slice display window will appear on the desktop. Move the mouse to the image
display. Click in the image at a starting point. In the slice display window, a plot of
the image amplitude along the column of the starting point will be displayed.
Dragging the mouse in the image will cause a dynamic display of each column as

GPR Processing Environment -- User’s Manual 57



Post Processing

the mouse is moved. When finished, release the mouse button. To remove the slice
display window, click the Dismiss button in the window.

The three slice functions may also be started in the Edit menu by selecting the
Endpoint Profile, Row Profile, and Column Profile selections.

Annotation

The main purpose of the Post-Processing Tool is to allow object-oriented
annotation of processed GPR images. Text, lines, boxes, and ellipses may be added
to images. They are object-oriented in the sense that each is considered its own
entity, capable of being selected, deleted, copied, pasted, etc. The Post-Processing
Tool provides an excellent system for preparing documentation of GPR analysis
results.

Tool Use

The annotation functions may be selected using buttons on the Button Bar or
through selections in the Create menu. The functions operate in a similar fashion to
most graphic design applications and Windows programs. Control for each tool is
described in the Command Feedback Display when the function is selected.

i'w:f:] -Text layout tool. Click the button. Select text location in image. A text

attribute selection window will appear. Enter text in input box. Set any desired
attributes such as color, line width, font, fill color, angle, etc. Press OK.

?\1 -Line tool. Click the button. Click and hold the left mouse button at the

starting point of the desired line. Drag the mouse to the endpoint of the line, and
then release the mouse button. Holding the CONTROL key forces the line to be
either vertical or horizontal.

1l -Rectangle tool. Click the button. Click and hold the left mouse button at the

starting point of the desired box. Drag the mouse to the end corner of the box, and
release the mouse button. Holding the CONTROL key forces the box to be square.
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3| -Ellipse tool. Click the button. Click and hold the left mouse button at the

starting point of the desired ellipse. Drag the mouse to the end point of the ellipse
and release the mouse button. Holding the CONTROL key forces the ellipse to be a
circle.

-Object selection tool. Click the button. Click on a drawn object or drag a box

around the object. The object will be selected. Click on the object and drag it to
move the object. Click and drag the control points to change the object shape.
Double clicking on an object brings up an attributes control window for the object.
Multiple objects may be selected or deselected by holding the SHIFT key. Once an
object is selected it may be deleted, copied and pasted, or its attributes may be
changed by selecting Selected Object... in the Attributes menu. Objects may be
deselected by re-selecting them with the SHIFT key held down. All objects may by
deselected at once by choosing Deselect All from the Edit menu.

A -Redraw. Click the button. The display will be redrawn.

-Cut. Select an object. Click the button. The object will be cut to the clipboard

5

for pasting.

Object properties

Each object has several attributes including: color, line width, fill color, etc. The
default attributes for each type of object may be set by selecting the object type
from under Defaults in the Attributes menu. Once the defaults have been set, each
new object will have the attributes of the default settings for that object type. To
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change the attributes of a previously drawn object, select the object using the
Object Selection Tool. The either double click on the object or choose the Selected
Object... option in the Attributes menu.

Grouping Objects

Multiple annotation objects may be grouped together. Once grouped, the objects
are treated as one entity when cutting, copying, pasting, etc. A group of objects
may be ungrouped at any time.

To group multiple objects:

Select the object selection tool using the Button Bar or
Object Select from the Edit menu. Click in the display
window and drag a box around the objects that need to
be grouped. All objects in the box will be selected.
Multiple objects may also be selected one by one using
the mouse to select them if the SHIFT key is held
down. All objects in the image may be selected at once
using the Select All option in the Edit menu. Once the
desired objects have been selected, choose Group from
the Edit menu. The objects will be grouped and
considered as one entity.

To ungroup objects:

Using the object selection tool, select the group of objects to be ungrouped. Choose
Ungroup from the Edit menu. The group will be separated and each object will be
treated as its own entity.

Changing Object Order

Objects are stacked on top of each other when displayed in the image window.
Objects on top cover and hide objects below them. The order is determined by the
order in which the objects were drawn. The last object drawn always covers the
previously drawn objects. The order of the objects may, however, be forced to a
desired order.
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To change an object order in the display stack:

Use the object selection tool to choose an object. The selected object may be moved
to the front or back of the display stack by choosing Front or Back respectively
from the Edit menu. By selecting the objects one by one in the desired stacking
order and shifting then in the same direction, back or front, the desired order may
be achieved.

Input/Output

The Post-Processing Tool serves to provide a method for annotating GPR analysis
results for FDOT documentation. The tool allows annotated results to be printed on
paper for a hardcopy or to file for importing in word processing or graphic design
software. Annotated images may also be saved to disk for later access and changes.

e Save/Restore
¢ Export Graphics

e Print

Save/Restore

Annotated images may be saved and restored. The objects are preserved as separate
entities to allow modification at a later time.

To save an annotated image:

An annotated image may be saved using the Save or Save As... choices in the File

menu. Save As... will start a file selection tool to allow the file name to be chosen.

Save will save the image to file using the name previously selected. All objects will
be saved as their own entities. This allows the annotations to be changed later.

To restore an annotated image:

Restore an annotated image by selecting Restore... from the File menu. A file
selection tool will appear for selection of the desired file. The file will be loaded.
Annotations may then be changed or added.

GPR ‘Processing Environment -- User’s Manual 61



Post Processing

Export Graphics

The annotated image may be exported as a graphic file for use in most popular word
processing and graphic design applications. Several file formats are available to
ensure compatibility: GIF, BMP, JPG, and TIF.

To export an annotated profile to a graphic file:

Export to a graphic file by selecting one of the export options from the File menu:
Export as GIF - Compuserve Graphics Interchange Format
Export as BMP - Window or OS/2 Bitmap

Export as JPG - Joint Photographic Experts Group format

Export as TIF - Tagged Image File format

Once a file format has been selected, a file selection tool will appear. Select the
desired file name and then press OK. The annotated image will be exported to the
desired file using the appropriate file format. Most word processing and graphic
design software is capable of importing at least one of the file formats available.

Print

The annotated profile may be printed to the installed printers using the Post-
Processing Tool.

To print an annotated profile:

To print an image select Print... from the File menu.
A print tool will appear. The tool allows selection of
the desired printer and configuration of printer
parameters. The printer features are controlled by
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software from the printer manufacturer and Windows. After the parameters are set,
select OK to print the image.

Lawea)d 4000 Seriee PS Documend Setings
et

To change the page setup:

Selecting Page Setup... from the File menu will
start a page setup tool. The tool allows page
parameters to be set including: page height, page
width, offsets, etc. There is also a button to
select Window Metafile output. If this button is
selected, the Print... command in the File menu
will ask for a file name and print to a file in
Windows Metafile format. This format may be
imported in some graphic design applications.
The format preserves objects as their own
entities so that the annotation may be changed
within other software. This format may not be 100% compatible with other
software. '

To print to 3 Window Metafile:

Choose Page Setup... from the File menu to start the page setup tool. Select the
Window Metafile option. Close the tool and then select Print... from the File menu.
A tool will appear for input of a file name. Type the desired filename and press OK.
The annotated image will be printed to file using the Windows Metafile format.
This format may be imported in some graphic design applications. The format
preserves objects as their own entities so that the annotation may be changed within
other software. This format may not be 100% compatible with other software.
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CHAPTER 6

GPR Techniques

The chapter serves to emphasize some basic GPR data collection and analysis
principles which can aid in producing quality analysis results. It covers the
following:

¢ Overview

e Collection Techniques

¢ Analysis Techniques

Overview

Ground penetrating radar collection and analysis are not an exact science, meaning
there are no well-defined, specific procedures or routines which always guarantee
excellent results. At least for the time being, GPR will continue to rely on
experience gained through use over time. However, through careful methods and
powerful, intelligent processing techniques subsurface analysis efficiency and
confidence can be improved. Experienced operators will benefit from reduced
analysis time requirements and new operators will gain appreciable experience
quicker due to effective collection methods, increased processing speed, and more
informative subsurface profiles generated by powerful algorithms.
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Collection Techniques

Taking a scientific approach to GPR data collection benefits analysis and GPR
processing algorithms. Rigorous attention to detail and well-defined collection
techniques produce higher quality data sets and result in more informative data.

Appropriate Radar Configuration

The radar, being the sole data collection device, must be configured properly for
effective subsurface imaging.

1. Antenna center frequency

The antenna frequency determines the penetration depth and the achievable
resolution of objects in the return. Penetration depth and resolution are
proportional. Higher frequency antennas provide finer, better resolution but reduced
penetration depth. Lower frequency antennas penetrate deeper but provide worse
resolution. For this reason, the highest frequency antenna able to achieve the
desired depth should be used to provide the best resolution. Multiple data
collections might even be considered using a higher frequency antenna to image
close objects at a better resolution and utilizing a lower frequency antenna for
deeper objects.

2. Time range

The time length measured for each pulse determines the maximum depth to which
an object may be imaged, subject to the dielectric constant of the surrounding
medium. This range should be set such that it may “see” deep enough for objects of
interest. However, it should not be set significantly deeper than required, or the
cross-range sample resolution will have to be reduced by the radar. It is also useless
to atterpt to record returns from objects which are deeper (longer travel time) than
may be seen due to the attenuation of the electromagnetic signal in the subsurface.

3. Sample rate

The radar is usually run for geophysical applications in continuous sample mode.
The sample rate should typically be set as fast as the radar can achieve (limited by
the required time range), to give the best results. This produces better cross-range
resolution or, at the sacrifice of resolution, allows reduction of noise by stacking
methods.
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4, Samples per scan

The number of samples per scan should be set as high as the radar can achieve for
the best resolution in the data. Size of individual traverses in typical geophysical
applications do not create a data storage problem at maximum rates.

5. Filters

Care should be taken in setting the filters in the radar system. It is essential that the
center frequency not be filtered out of the received signal. A significant bandwidth
should be allowed to pass surrounding the center frequency to ensure quality results
and resolution. It is best to filter out very little of the received signal. Perhaps very
high and very low frequencies may be filtered out to reduce noise.

6. Gain function

The gain function should also be set very carefully. Extremely high gain functions
amplify noise significantly and may cause clipping. The gain should not be set to
produce a large response when there is nothing to reflect the signal underneath the
antenna in the subsurface. When an actual object is passed a legitimate response
will be received. This response, will then be greatly amplified and signal clipping
will most likely result. If nothing is below the antenna, no response should be seen
by the radar. This is a normal occurrence.

Survey Area Preparation

Collection from a well prepared area produces more precise results.

1. Clear area

Any materials on the surface which may encounter the antenna or produce a
response should be removed. This is especially true for metallic objects. The
antenna should be pulled evenly over as smooth of a surface as possible.

2. Grid area

The survey site should be sectioned into a grid system. Such a system allows the
operator to collect data along more precise traverses. It also allows markers to be
placed in the data at more precise locations for a better cross-range sample interval
estimate.
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Data Collection

1. Traverse rate

The GPR system samples at a constant rate, which causes the cross-range sample
interval to depend on the traverse rate. To provide an consistent sample interval the
antenna must be pulled at a perfectly even rate. However, the antenna is pulled
manually by an operator who is walking. A walking traverse rate is never consistent
so neither is the sample interval. Fluctuating sample intervals distort the shapes of
returns from objects in the subsurface and, thus, inhibit some methods of
processing such returns. For this reason, great care should be taken to traverse at as
even a rate as possible. Often clearing the survey area helps keep the antenna from
catching and jerking on surface articles which prevent a constant rate.

2. File storage

It is important to limit the size of files during data collection. Small files are more
manageable and reduce processing time. If files are too large they may not even be
capable of being loaded into processing software. A good way of keeping files
manageable is to file data from each traverse along a gridline of the collection area
in a separate file. This may be done automatically by the radar system using Stop/
Start mode of data collection.

Analysis Techniques

It is important to realize that no one method of analysis is correct. Often several
procedures must be used to produce desired results. The GPRSPE presents many
options for processing, easy access and control of algorithms, and efficient
comparison and visualization of GPR profiles. The system provides an excellent
tool to extract as much information from GPR returns as possible for an informed
interpretation. No one process solves every problem, however there are some
guidelines that often serve to make analysis more effective.

1. Process small data sets

Processing speeds are directly related to the amount of data being processed. As
speed is important for efficient analysis, small profile regions of interest should be
processed at any one time rather than processing long traces of data at once. This
reduces the memory required by the system to process the data in addition to
reducing the amount of data to process. Both of these aspects result in much shorter
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processing times. Cropping of profiles using the GPRSPE allows selection of a
region of interest, and deleting allows unnecessary sections to be removed.

2. Gain function removal

Many times the gain function makes deeper objects visible. However, this is not
always beneficial for the processing routines, like Adaptive Inversion, for example.
The gain function should often be removed prior to processing to prevent adverse
affects on the algorithms. Display filters, such as dB display and histogram
equalization, often make up for the lack of an added gain function.

3. Point objects

When the application specifically involves the location of buried point targets, such
as pipes, cables, or rebar, migration may often provide a beneficial method of
increasing the cross-range resolution by focusing hyperbolic returns. For objects
with extent, migration is not typically as helpful.

4. Typical unknown profiles

For profiles where little is known about the subsurface, adaptive inversion and
multiresolution analysis often provide the best results. These algorithms tend to
resolve some of the features of returns from objects and features of the subsurface
and produce a more informative display. They will also often bring out returns
which were previously not visible or features which were too cluttered to be
noticeable.

Impulse forcing may also provide useful results by emphasizing contours and
features of the data that were not directly recognizable. This method of processing
is helpful in a cluttered response for illustrating correlated returns from neighboring
traces.
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Adaptive Filter - a filter which is designed to change itself over time to minimize the error be-
tween its output and some desired response. 43

Background Noise - unwanted signal received and measured by the radar which often clutters
a profile display. Often a result of random thermal noise within the radar
system or receive electromagnetic radiation from other electromagnetic
sources. 41

Blind Deconvolution - Separating two signals given only the combined signal. Assumptions
must be made about the characteristics of the two signals which will al-
low separation. 43

Colorscale - the array of colors allotted for the display of data. Each color is assigned to repre-
sent a data value in the display according to some allocation scheme.
Points in the data set are displayed using the color closest to their data
value. 14

Convolution - the mathematical process of filtering a time series or signal with another signal/
filter. 42
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Deconvolution - the mathematical process of separating one signal/filter from the output signal
given the other signal/filter. 43

Dielectric Constant - a parameter of any medium which determines the velocity of electromag-
netic waves within that medium. 15

Gain Function - a function applied to each trace which amplifies the data according to its sam-
ple number. Typically, in GPR, early samples receive little amplifica-
tion while late samples in a trace receive larger amplification. This helps
account for the 14

Interference - distorted response due to overlap between responses from multiple targets which
have added together making the return from each individual object less
recognizable. 36

Migration - focusing the hyperbolic responses of point targets to more point-like response for
improved recognition and localization. 36

Multiresolution Analysis - study of a signal by decomposition of its time series into a range of
resolutions using the Wavelet Transform. 47

Profile - a GPR image of the subsurface consisting of a series of traces, which are recorded as
the radar antenna is traversed along the surface. 13

Trace - one measured pulse of the radar consisting of a series of samples/measurements as elec-
tromagnetic wave propagates into the ground and returns from subsur-
face reflections. 13

Wavelet Transform - maps the correlation between a signal and a wavelet function verses scale/
resolution and time. 47

72 GPR Processing Environment -- User’s Manual



Index

A
absolute value 21
adaptive filter 43
adaptation rate 45
filter order 44
adaptive inversion 42, 69
annotation 58
box 58
copy 59
cut 59
delete 59
ellipse 59
grouping objects 60
line 58
object order 60
object properties 59
object selection 59
paste 59
text 58
ungrouping objects 60

B
background noise 41
background removal 41
automatic 42
manual 42
beamwidth 36, 38
blind deconvolution 42, 43
BMP 62
button bar 15

C
color
selection 24
color assignment 22
colorscale 14, 22
colortable 24
modifying 25
selecting 25, 26
command feedback
display 14
convolution 42
cross-range 13, 19
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D
data collection
file storage 68
fraverse rate 68
deconvolution 43
depth
display 15
dielectric constant 15, 38, 40
down-range scale 27
estimation 38, 40
display
button bar 15
colors 24
command feedback 14
down-range 15
format 27
filename 14
filters 20
absolute value 21

histogram equalization 22

median 23

signed decibel 20
gain function 13
menu bar 15
parameters 14
profile 13
redraw 28
scroll bars 13
sketching 32
vertical axis 13
vertical scale

format 27
zoom 28

down-range 13

display options 27

E
editing
cropping 29, 68
deleting 30
modifying gain function 31
removing gain 30, 69
exporting graphics 62

BMP 62
GIF 62
JPG 62
TIF 62

F
file
handling 17
load 17
save 18
filters
absolute value 21
histogram equalization 22
median 23
signed decibel 20
Fourier Transform 39
analysis 46
frequency analysis 46

G
gain function
display 13
modifying 31
radar system 67
removing 30, 69
GIF 62
graphics
export 62
exporting
BMP 62
GIF 62
JPG 62

TIF 62

H
histogram equalization 22

}
impulse forcing 45, 69
interference 36

J
JPG 62
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M
median filter 23
menu bar 15
operation 15, 53
metafile 63
migration 35, 36, 69
FFT method 39
simple method 36
multiresolution analysis 46, 69
wavelet transform 47

N
navigation 19, 54
scroll bars 13, 20, 54

]
point objects 69
post processing
annotation 58
box 58
copy 59
cut 59
delete 59
ellipse 59
grouping objects 60
line 58
object order 60
object properties 59
object selection 59
paste 59
text 58
ungrouping objects 60
basics 51
initialization 52
data range selection 56
display 52
button bar 53
command feedback 53
image window 52
menu bar 53

parameters 55

auto redraw 55

brightness 55
contrast 55

view attributes 55
properties control 53

zoom control 53

selected data 53

exiting 54
exporting graphics 62
BMP 62
GIF 62
JPG 62
TIF 62
image navigation 54
object order 60
object properties 59
printing 62
metafile 63
page setup 63
profile/slice display 57
column 57
endpoint 57
row 57
redraw 59
restoring from file 61
saving to file 61
slice display 57
column 57
endpoint 57

row 57

zoom 56
printing 62
metafile 63
page setup 63
processing 35
adaptive inversion 42, 69
background removal 41
automatic 42
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manual 42
impulse forcing 45, 69
migration 35, 69

FFT method 39

simple method 36

multiresolution analysis 46, 69
point objects 69
techniques 68
thresholding 40
profile 13
annotation 58
cropping 29, 68
delete section 30
display window 13
gain removal 30, 69
load 17
modify gain 31
navigation 19
printing 62
metafile 63
page setup 63
processing 35
adaptive inversion 42, 69

background removal 41
impulse forcing 45, 69
migration 35, 69
FFT method 39
simple method 36

multiresolution  analysis 46,

69

thresholding 40
reload 16
save 18
save selection 18
sketching 32

R

radar

antenna center frequency 66
configuration 66
filters 67

gain function 67

sample rate 66

samples per scan 66

time range 66
redraw 28

clear sketching 33
register

copy 16

management 16

reload 16

switch 16

s
salt and pepper noise 23
signed decibel 20
sketching 32
boxes 33
circles 33
clearing 33
lines 33
text 33
software
basic procedures 12
display 12
exiting 18
initialization 12
overview 11
starting 12

T
techniques 65
analysis 68
area preparation 67
data collection 66, 68
threshold 37, 46
thresholding 40
TIF 62
trace 13

w

wavelet
function 48
scale 48
transform 47

Wavelet Analysis Tool 48
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z

zoom 28
options 56
selected range 56
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